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Important Notice

Because of the nature of wireless communications, transmission and reception of data can never be guaranteed.
Data may be delayed, corrupted (i.e., have errors) or be totally lost.  Although significant delays or losses of data are
rare when wireless devices such as the Sierra Wireless modem are used in a normal manner with a well-constructed
network, the Sierra Wireless modem should not be used in situations where failure to transmit or receive data could
result in damage of any kind to the user or any other party, including but not limited to personal injury, death, or loss
of property.  Sierra Wireless, Inc., accepts no responsibility for damages of any kind resulting from delays or errors
in data transmitted or received using the Sierra Wireless modem, or for failure of the Sierra Wireless modem to
transmit or receive such data.

Safety and Hazards

Do not operate the Sierra Wireless modem in areas where blasting is in progress, where explosive atmospheres may
be present, near medical equipment, near life support equipment, or any equipment which may be susceptible to any
form of radio interference.  In such areas, the Sierra Wireless modem MUST BE TURNED OFF.  The Sierra
Wireless modem can transmit signals that could interfere with this equipment.

Do not operate the Sierra Wireless modem in any aircraft, whether the aircraft is on the ground or in flight.  In
aircraft, the Sierra Wireless modem MUST BE TURNED OFF.  When operating, the Sierra Wireless modem can
transmit signals that could interfere with various onboard systems.

The driver or operator of any vehicle should not operate the Sierra Wireless modem while in control of a vehicle.
Doing so will detract from the driver or operator’s control and operation of that vehicle.  In some states and
provinces, operating such communications devices while in control of a vehicle is an offence.

Patents

Portions of this product are covered by some or all of the following US patents: D367062, D372248, D372701,
5515013, 5617106, 5629960, 5682602, 5748449, and other patents pending.

Copyright

©1999 Sierra Wireless, Inc. All rights reserved.
Printed in Canada.

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, without the prior permission of the publisher.

The information in this manual is subject to change without notice and does not represent a commitment on the part
of Sierra Wireless, Inc.  Sierra Wireless, Inc. shall not be liable for incidental or consequential damages resulting
from the furnishing, performance, or use of this manual.

The Watcher™ and WirelessExpert™ software described in this manual are copyright 1998 Sierra Wireless, Inc. All
rights reserved.

Trademarks

Watcher™ and WirelessExpert™ are trademarks of Sierra Wireless, Inc.

Windows® and Microsoft® are registered trademarks of Microsoft Corporation.

Hayes™ is a trademark of Hayes Microcomputer Products, Inc.

All other brand or product names, logos, trademarks, etc. mentioned in this manual are owned by their respective
companies.
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Regulatory Information

The equipment certifications appropriate to your device are marked on the device and the accompanying product
specific information.  Where appropriate, the use of the equipment is subject to the following conditions:

CAUTION

Unauthorized modifications or changes not expressly approved by Sierra Wireless, Inc.
could void compliance with regulatory rules, and thereby your authority to use this
equipment.

!!
WARNING (EMI) - United States FCC Information

This equipment has been tested and found to comply with the Class B limits pursuant to
Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection
against harmful interference in an appropriate installation.  This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio
communication.  However, there is no guarantee that interference will not occur in a
particular installation.  If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

• Reorient or relocate the receiving antenna

• Increase the separation between the equipment and receiver

• Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected

• Consult the dealer or an experienced radio/TV technician for help

!!
WARNING (EMI) – Canada

This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus as set out in the interference causing equipment standard
entitled 'Digital Apparatus', ICES-003 of the Department of Communications.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux
appareils numériques de Classe B prescrites dans la norme sur le matériel brouilleur:
'Appareils Numériques', NHB-003 édictée par le ministre des Communications.

RSA Licensee

If you have purchased this product under a United States Government contract, it shall be subject to

restrictions as set forth in subparagraph (c)(1)(ii) of Defense Federal Acquisitions Regulations
(DFARs) Section 252.227-7013 for Department of Defense contracts, and as set forth in Federal

Acquisitions Regulations (FARs) Section 52.227-19 for civilian agency contracts or any successor
regulations.  If further government regulations apply, it is your responsibility to ensure compliance with such
regulations.
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Contact Information

Sierra Wireless, Inc. Telephone: (604) 231-1100
13575 Commerce Parkway Fax: (604) 231-1109
Suite 150
Richmond, BC e-mail: support@sierrawireless.com
V6V 2L1 Web: www.sierrawireless.com

Customer Service

Help Desk

Open between 6:00 a.m. and 5:00 p.m. Pacific Time

(604) 231-1128

Warranty and Service Desk

Open between 8:00 a.m. and 5:00 p.m. Pacific Time

(604) 231-1157

support@sierrawireless.com

Sales Desk

Open between 8:00 a.m. and 5:00 p.m. Pacific Time

(604) 231-1100

sales@sierrawireless.com

Web

Consult our webpage for
up-to-date product descriptions, documentation,

application notes, firmware upgrades,
troubleshooting tips, and press releases:

wwwwww..ssiieerrrraawwiirreelleessss..ccoomm
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1. About this Guide

1.1. Introduction

This guide is intended to assist both hardware integrators and application software developers with
the setup, installation, testing, and design of applications for the Sierra Wireless SB300 Series
OEM modems.  You should be familiar with the use of modems, communication media (PSTN
and Cellular), protocols, and the use of AT commands.

This guide describes the full feature set of the entire SB300 series, so some sections may not apply
to the particular model you are using.  Consult the Product Descriptions for a summary of the
features available on each product.

1.1.1. Getting Started

Chapter 2 covers the setup up of the OEM Developer’s Toolkit (the toolkit) and establishing host
communication with the modem.  If you have any uncertainties about the Multipurpose Interface
Board (MIB), the modem, or the connectors, consult the Hardware View reference chapters.

1.1.2. Operational View

The main body of this document covers the operational issues of the SB300 Series modems.

Installation and use of the application software Watcher and WirelessExpert™ is covered.  These
programs are designed to manage use of the modem in a Microsoft Windows® 95/98/NT
environment without the need for further interface programming.

If custom applications are required, additional information is provided covering connection issues
and tips for writing applications.  A complete reference to the available modem commands is in a
separate document (2110031 included with the toolkit).

Use of a terminal application for initial setup and testing of a modem may be required.  Terminal
emulation software is not provided nor described in this guide.

1.1.3. Hardware View

This guide provides product descriptions of the SB300 Series OEM modems including the
information needed for the physical integration of the modems.

A full description of the Multipurpose Interface Board provided with the OEM Developer’s
Toolkit is also included in this guide.
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1.1.4. OEM Developer’s Toolkit Checklist

Your toolkit should include the following parts:

SWI Part No. Description

1200054 Multipurpose Interface Board (MIB)

1900000 AC Adapter

006.0011 10’ Serial Cable with 9-pin D connectors

006.0002 Telephone Cable

2000067 16-Pin Ribbon Connector (for SB302)

2000068 30-Pin Flat Flex Cable (for SB300 and SB320)

2000071 13-Pin  I/O connector (for SB320)

1810009 Magnetic Mount Cellular Antenna with coaxial cable

2000066 Cable Adapter for antenna coax to SB modems.

Software envelope with licensing agreement containing:

Watcher and WirelessExpert™ Revision 3.2.1 or above.

2110031 SB300 Series OEM Modems AT Command Reference

2110059 SB300 Series OEM Modems User’s Guide (this document)

1.2. References

For detailed information on the command interface of an SB300 Series modem, consult the Sierra
Wireless SB300 Series OEM Modems AT Command Reference, document number 2110031,
included in toolkit.

For additional details of specific uses for these commands, troubleshooting tips, and the latest
updates, refer to the Sierra Wireless Internet site at www.sierrawireless.com.

For background information on the nature of wireless communications consult your cellular
service provider and/or their Internet site.  All major service providers provide web-based
information on CSC and CDPD.

1.3. Currency

This document is under ongoing revision to maintain currency with product development.  Please
check our web site frequently for revisions.  This edition is:

Rev 1.0 February 11, 1999

This document is current with modem firmware revision R1.0.1.  To determine your firmware
revision you must establish a host terminal connection to your modem as described in the next
chapter and follow these steps:

1. Enter the Identification command ATI5
The modem will respond with the Firmware revision information:

R1-0-1 …

The details following the revision number may vary depending on the mode of the modem.

If your modem firmware is an earlier version, you can download the updated version from our
web site at www.sierrawireless.com.  Instructions for updating the modem firmware are contained
in Section 3.8 Updating Modem Firmware.
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1.4. Document Structure

This document focuses on the operational view.  The hardware view is covered in a reference
section at the end.

There is a Getting Started chapter in this section intended to help you quickly get the toolkit
components connected and communicating.

The operational view follows, starting with the basics of the Watcher and WirelessExpert™
software provided with the toolkit.  Important background on the modem basics, including
terminology used in this guide, starts you into the operational elements of getting your modem
configured and operating.  There are separate chapters covering modem operation in each of the
three possible modes with sample configurations.

The hardware view is covered in two chapters.  The first describes the modem product
descriptions including the hardware integration issues of each of the modems.  The second is a
reference to the Multipurpose Interface Board (MIB) used to test and configure the modem during
product development.

1.4.1. Modem Operations

The various modes, states, and conditions the modem can be placed in are described in the chapter
on Basic Modem Operations.  That chapter also discusses the communication interface between
the host (DTE) and the modem.

The types of protocols supported in each mode are described but examples of configuring the
modem will be found in the chapters on operations for each specific mode.

1.5. Conventions Used in this Reference

Hardware signals are named with a convention of:

NAME active high (5 Volts)
\NAME active low (0 Volts)

Result Code – This is a numeric or text code that is returned after all commands (except resets).

Response – This term indicates a response from the modem which is issued prior to a return code.
Reading registers or issuing commands that report information will provide a response followed
by a return code unless the command generates an error.

Hexadecimal values are shown with a prefix of 0x, i.e. in the form 0x3F.

Character codes which are described with words or standard abbreviations are shown within angle
brackets: such as <CR> for Carriage Return and <space> for a blank space character.

AT Command and register syntax is noted using an alternate font:

AT+WS46=4
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2. Getting Started

2.1. Introduction

This chapter guides you through the initial physical setup of a host terminal (usually a PC), the
Multipurpose Interface Board (MIB), and a modem.  Related start-up issues such as cellular
activation are also covered.  If you have any difficulties, consult the reference chapters in the
Hardware View to become more familiar with the components and their setup.

After completing this chapter, you should be able to communicate (DTE to DCE) with the modem
by using AT commands from a host terminal.  Modem connection to a remote modem is not
covered until the Operational View.

The chapters immediately following deal with the Operational View.  Software Installation will
deal with the installation on a host PC of the Watcher and WirelessExpert™ software which make
further configuration of the modem and testing on a CDPD network (if applicable) much simpler.

A reference section covering the Hardware View follows at the end of the manual.

2.2. Registration

Before you can use your modem for wireless communication you must register it with a cellular
service provider.  This section describes what they will need to know and what information they
will provide to you.

Contact your service provider to get the registration process started.  While the service provider is
getting your account configured, you can install and configure your modem.  Record the
information provided by your carrier for configuring the modem later.

In any coverage area there can be two providers, each assigned to a “side” (A or B) of the cellular
waveband.  Each provider is also assigned a Service Provider Network Identifier (SPNI) number.

2.2.1. CDPD

To use your modem in CDPD mode it must be activated on a CDPD network by a service
provider.  To register your modem for Wireless IP activation on CDPD networks, contact your
local CDPD service provider.

Give the CDPD service provider the Equipment Identifier (EID).  This is the identification
number of the radio/modem.  A Sierra Wireless modem EID has the following format:

00-A0-D5-xx-xx-xx

Look for this number on the back of your modem and on a label affixed to the outside of the
package that the modem was shipped in.  If only the ESN (Electronic Serial Number) can be found
you can convert it to a Sierra Wireless EID by expressing the last 8 digits as hexadecimal values.
For example:

ESN: 206 - 00057628 = EID: 00-A0-D5-00-E1-1C
57628 = 0xE11C

The EID number is also available by querying the modem with the AT+WPEID command.

The CDPD service provider supplies the following:
1. Modem address, sometimes referred to as a Network Entity Identifier (NEI).  This may also

be referred to as your Internet Protocol (IP) address.  This identifies your modem on a CDPD
network and on the Internet.
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2. IP address of a router or server to ping when testing the connection.  This may be a Domain
Name Server (DNS).

Both of the above items are in the form of an IP number.  This is made up of four numbers
ranging in value from 0 to 255, separated with periods (sample: 192.168.0.9)

3. Side designator, A or B.  This determines the channels used by your CDPD service provider.
4. SPNI number of the provider.  This is optional.  The Service Provider Network Identifier

(SPNI) can be used to restrict the modem to accepting service from a limited list of providers
and can help speed up cellular channel acquisition and registration.

This information will be required when configuring your modem for CDPD registration either
with WirelessExpert or AT commands.

2.2.2. CSC (AMPS)

To use your SB320 modem in CSC mode it must be activated with a cellular phone service
provider.  To register your modem for CSC activation, contact your local cellular carrier.

Give the service provider the Electronic Serial Number (ESN).  This is the identification number
of the radio/modem.  A Sierra Wireless ESN has the following format: 206-xxxxxxxx.  Look for
this number on the back of your modem and on a label affixed to the outside of the package that
the modem was shipped in.  The number is also available by querying the modem with the
AT+WVESN command.

The cellular service provider supplies the following:
1. A Number Assignment Module (NAM).  This is your cellular telephone number and your

Home System ID (SID).
2. Side designator, A or B.  This determines the channels used by your service provider.

This information will be required when configuring your modem for CSC mode use either with
WirelessExpert or AT commands.

2.2.3. Wireline

There are no particular setup issues to configure your SB320 modem for use in wireline mode.  It
is required that the telephone line be analogue and not digital as found on some PBX systems.

2.3. Setup Considerations

2.3.1. Host Computer Terminal

You will require a PC with a communications program capable of operating in ASCII terminal
emulation mode.  This allows the PC to function as a terminal attached to the modem and permits
the entering of AT commands required for modem setup and diagnostics.  We recommend that the
program chosen be capable of logging terminal communications activity to a file for later analysis
or printout in the event that technical support is required.

For IBM PC-compatibles, Windows Terminal, Hyperterminal, Procomm, and Kermit are all
acceptable.  Note that early versions of Hyperterminal do not allow you to send SLIP framing
characters to the modem, preventing use of the escape sequence.  This is corrected in later
versions.

A 9-pin D connector RS-232 serial cable (part number 006.0011) is provided with the OEM
Developer’s Kit for connecting the PC host to the Multipurpose Interface Board.
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2.3.2. Physical considerations

NOTE

The MIB and modem can be sensitive to static so the work surface should be a static
controlled environment.

2.3.3. Antenna considerations

The SB300 Series modem uses standard mobile cellular radio signals.  An antenna (part
number 1810009) is provided with the OEM Developer’s Kit.  Along with this antenna is a
connector adapter (part number 2000066) to convert the antenna connector (Male SMA) to match
the modem requirement (Male MMCX).

You can use an antenna of your own if you choose.  Any standard cellular antenna of good quality
with a maximum system gain of 3 dB (FCC requirement) will function properly provided you
have a suitable connector.

Antenna performance is subject to the following guidelines:

Location – Locate the antenna as far away from personnel as possible to minimize signal
blocking.  For optimum reception, in indoor fixed location applications, position the antenna
above the height of personnel and nearby equipment or structures.  Locate the antenna as close to a
window as possible.

Cabling – Select a low loss, high quality, 50-ohm, coaxial cable with the appropriate connectors.
The cable can be any length, but lengths greater than 4 metres (13.1 feet) increase cable loss and
offset the antenna’s nominal gain.  If longer length cables are required, use a heavier wire gauge to
reduce the dB loss/m and to minimize the effect of the cable loss on antenna gain.

Ground Plane – For installations where a good antenna ground plane (metal surface) is not
available, use a non-ground plane type of antenna to help maximize signal reception.

Proximity to Other Antennas – In general, do not locate the SB300 Series modem and its
antenna closer than 1.5 metres (5 feet) to another antenna.  In certain cases even more separation is
required.  The effect of the interference from two-way transmitters varies from slowing down
response times to blocking modem transmission.

2.4. MIB Presets

The Multipurpose Interface Board has several switches and jumpers which should be configured
as follows for the initial setup.
• DIP Switch in the Serial Breakout Box:

Switches 1 through 8 should be closed (on)
Switches 9 and 10 open (off).

• Power Select (J21) should be on pins 1 – 2 (+5V).
• HOSTSHDN, \SHDN, and MODEM DIS jumpers on J24 should all be off.
• Speaker Enable should be on.

2.5. Connections

This section describes the steps to connect the PC host, MIB, and modem.  At the end of this
procedure you should be ready to configure and use the modem.  If results at any step are not as
described, consult the chapter on troubleshooting.

To connect follow these steps:
1. Attach the RS-232 serial cable from the host to the MIB PC Serial Port connector (J1).

The Serial Breakout Box indicators for DTR, TxD, and RTS should all light (powered from
the RS-232 connection).
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2. Start the terminal application on the host PC.  Configure the application for the port connected
to the MIB.  At this time, the modem requires a setting of 19200 bps, 8 data, no parity, 1 stop,
with hardware (RTS/CTS) flow control.

3. Instruct the terminal application to connect.
The DTR and RTS indicators should be green.  The TxD indicator should be red.

4. Attach the appropriate modem connector strap to the MIB port for the modem to be used.

• SB302 – 2x8-pin ribbon with connectors.

• SB300 and SB320 – 30-pin 5mm flex strap (without connectors).
To make the SB300/320 connection:
i. Open the hinged SB300/SB320 connector on the MIB by lifting it away from the

edge of the board.
ii. Slide the strap into the connector with the contact side down (coloured side up).

Be sure it is fully inserted.

iii. Close the connector by pressing down on the ends of the connector rather than the
centre.

iv. Connect the 13-pin  I/O cable to the MIB and the modem.  This connector is keyed
to prevent connection error.

5. Attach the modem to the connector strap using the same procedure as the MIB end of the
connector.

NOTE

Although the MIB provides support for the full SB Series of modems, it is not intended
to support more than one modem at a time.  Attaching more than one modem can
damage circuitry.

6. Place the antenna is a suitable location, attach the antenna connector adapter to the antenna
cable, and attach the cable to the modem.
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7. Ensure the modem power switch is OFF.
8. Connect the 12V DC power supply to the MIB.  The remaining LED indicators should come

on.  Power indicators for 7V and 5V should show red.  The Serial Breakout Box indicators
should all light; the DSR signal shows green.  All status indicators (S01 – S03) should show
red.

9. Switch on the modem power using the POWER switch on the MIB.
The Status indicators should go off and then begin operation to specification as the modem
initializes.  In about 6 to 10 seconds (following the modem’s internal initialization) the CTS
serial signal should go green and OK should appear on the PC terminal.

10. Type AT<enter> at the host terminal.  The modem should reply with OK.

The modem is now ready to be used with the host computer.

You may now continue to use the modem with the terminal application, or you may close the
terminal application and use Watcher and WirelessExpert (described below) to configure and use
the modem.
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The Operational View

3. Software Installation

3.1. Introduction

This chapter provides instructions for installing Watcher and WirelessExpert™ on a host PC and
using these programs to configure and use the modem.  It also includes procedures for updating
the firmware on the modem if needed.

NOTE

Running WirelessExpert is required before using Watcher.  WirelessExpert will install
and configure necessary drivers on the host PC.

Watcher

Watcher is a Windows application that configures and monitors Sierra Wireless modems for
CDPD, Circuit Switched Cellular (CSC), and Wireline operation.  This chapter explains how to
install Watcher and describes basic Watcher operations and important screen elements.

WirelessExpert

Installation of the drivers required for modem operations is performed with an installation wizard
called WirelessExpert.  This can be run at any time to view and edit the cellular activation settings
(NAMs, NEIs, etc.).  It allows you to test cellular connections.

3.2. Installing Software on the Host

The software is provided on CD-ROM.  The CD is self-starting when inserted into a PC running
Windows 95/98/NT.  An installation wizard will guide you through the process.

A menu folder is added to the Start > Programs menu:
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3.3. Configuration using WirelessExpert

WirelessExpert will automatically locate the modem on a COM port, interrogate it for features,
and install the required drivers on your host PC.  It will then allow you to set or alter the cellular
activation settings.

To make the modem drivers available to the Windows operating system, the PC may be restarted
part way through the execution of WirelessExpert.  This is done automatically but does require
that no other programs are running on the PC at the time.

Preparation:

1. Ensure the host serial connection to the modem via the MIB is in place and the modem power
is on.  The full set of serial communication LED indicators should be on.

2. For CDPD configurations:
a. Ensure the modem is in CDPD mode (+WS46=4).  This can be queried (AT+WS46?) to

verify.
b. Ensure the modem is set to auto-register (+WS173=1).

3. Close any open applications on the host PC including any communication program connected
to the modem.  A system restart supervised by WirelessExpert may fail if other programs are
running.  Leave the modem on.

4. Have the NAM / NEI and related information from your cellular service provider ready.  See
Section 2.2 for information on cellular service registration.

Installation:

1. Select Start > Programs > Watcher > WirelessExpert from the Windows taskbar.
2. Select the modem being used from the list:

SB320 – OR – SB300 Series for the SB300 or 302
3. Click Next > and then Next > again to skip the page regarding setup of other modem

products.  WirelessExpert then locates the COM port connected to the modem and finds the
related registry entries for it.  The results are displayed.

4. Click Next > to have WirelessExpert install the appropriate drivers for the modem.
5. A message may appear advising of the need to restart the computer.  Click OK.

WirelessExpert shuts down the computer and restarts it for you.
6. When the setup wizard reappears, continue to click Next > until you pass the section on

connectivity components.  WirelessExpert now examines the modem for cellular network
activation, reading any NAM and NEI entries stored on the modem.

7. The next page allows you to set the level of access to the configuration settings that will be
allowed to the Watcher program.  Setting “full access” will allow Watcher to alter the NAM /
NEI settings, “read-only” will allow Watcher to display the settings but you will have to use
WirelessExpert or direct AT commands to alter settings.

8. For SB320 installations, the NAM entries for CSC activation will be presented for entry and
editing.  This screen is automatically skipped for CDPD only modems.

9. For SB320 installations, WirelessExpert can test the connection provided you have a
registered NAM and a number to dial.  This tests that the modem can obtain a cellular channel
and place a call.  The called station can be your own voice line if you simply want to verify
that the modem can reach a destination phone number.  The test can be skipped by marking
the checkbox on the screen.  This test screen is automatically skipped for CDPD only
modems.

10. The CDPD settings of the modem are displayed for entry and editing.  A radio button sets the
active NEI for use.  A pull-down menu allows setting of the channel side preference.
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11. You are prompted to enter an IP address for a Domain Name Server (DNS).  Your cellular
service provider should have provided one.  This address is used for testing the CDPD
configuration by “pinging” the provided address.

12. The CDPD settings can now be tested by WirelessExpert and will be setup in the Windows
Dial-up Networking Connection facility.  A pull-down menu allows you to select the NEI to
use for the local end of the test.  If you select one different from the radio button selection on
the previous screen, the new setting will become the default.  This test will verify that you can
register with the CDPD network and will “ping” the DNS server to verify the connection.
The test can be skipped if desired.

13. Click Finish to complete the WirelessExpert configuration.  The modem should now be ready
for use.

WirelessExpert will have created an entry in Windows Dial-up Networking for CDPD mode.  You
may notice that it is configured to dial the number 2.  This is normal.  Although CDPD
connections do not actually dial a number, Windows Dial-up Networking requires that a telephone
number be entered.

3.4. About Watcher

Watcher is a configuration and monitoring tool to manage Sierra Wireless modems.  The program
can set the modem mode of operation (CDPD, CSC, or Wireline) and can be used to get
information about cellular connections and signals.  Watcher can also monitor modem connection
when using CDPD mode.

WirelessExpert must be run initially to properly install and register the required connectivity
components with Windows.  If you have not run WirelessExpert on the host PC to be used with
the modem it must be done before using Watcher.

3.5. Using Watcher for Modem Setup

When Watcher is started, it will check a registry on the PC to see what mode the modem was last
used in.  If it was CDPD then the program will open a CDPD connection using the settings in the
Dial-up Networking facility of Windows which were configured by WirelessExpert.  If an SB320
was last used in either CSC or Wireline mode then Watcher will attempt to set the modem to that
mode.

To start Watcher:

Select Start > Programs > Watcher > Watcher from the Windows taskbar.

Watcher will locate and initialize the modem.  It will then indicate the mode and condition of the
connection.

3.5.1. Configuring Watcher

Watcher has a setup dialog that lets you verify the Sierra Wireless modem connection to the COM
port, and the basic configuration strings Watcher will use for Circuit Switched Cellular and
Wireline operation.

To set up Watcher:
1. Make sure the modem is powered on and is communicating with your PC.

2. Select Options > Setup Watcher from the Watcher main menu
This will open the Setup Watcher dialog (next page).
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3. Click the WirelessExpert… button to activate the installation wizard described above.

4. If specialized setup strings are required for your installation, you can enter them here.  The
modem uses configuration strings to optimize its operation in certain modes.  The modem
comes preset with the most common configuration strings.  See the specific sections on CSC
and Wireline Operations for more information.
CDPD mode does not offer special setups.  To control CDPD mode use Options >
Setup CDPD… described below.

5. Click OK to save the configuration and return to the Watcher program window.

3.5.2. Configuring Cellular Settings using Watcher

Watcher’s ability to manage the cellular activation settings of the modem is set by WirelessExpert.
If WirelessExpert has set the access level for Watcher to anything but full access, then Watcher
cannot be used to configure the settings.

3.5.2.1. CDPD Settings

To edit the modem configuration with Watcher:

1. Select Start > Programs > Watcher > Watcher from the Windows taskbar.

2. If the modem is not in CDPD mode then select Settings > CDPD from Watcher’s main
menu.

3. Select Options > Setup CDPD… from the Watcher main menu.
The following window will open to allow configuration changes:

Note that the modem’s EID is displayed at the top of the window.

4. To change a NEI address you must click the Unlock button.

5. The Channel Set is a side preference dictated by your cellular service provider.

6. The SPNI box is used to enable the use of a restrictive list of service providers.  When the
modem is finding a channel, it can determine if a channel belongs to a provider whose SPNI
is on the list.  If the SPNI is not listed, then the modem will reject the channel and resume
searching.  If the list is enabled, use the Setup… button to maintain the list of accepted
SPNIs.

7. Registration mode allows you to select between manual and automatic registration.  If manual
is selected, Watcher will not try to register on the CDPD network until commanded to do so.
Automatic will set Watcher to register the modem when the program is started.



User’s Guide                                                                                                         Watcher and WirelessExpert

2110059 Rev 1.0 Proprietary and Confidential Page 15

8. Sleep mode is discussed in the CDPD Operations chapter.  Enabling it will allow the modem
to reduce power consumption when it is inactive, but response times will be slowed.  This
function sets the sleep timer to 30 seconds.

3.5.2.2. CSC Settings

If you are using a SB320, you can place the modem in CSC mode using Watcher.  The settings for
CSC can then be accessed.

To edit the modem’s CSC configuration with Watcher:

1. Select Start > Programs > Watcher > Watcher from the Windows taskbar.

2. If the modem is not in CSC mode then select Settings > Cellular from Watcher’s main
menu.

3. Select Options > Setup Cellular… from the Watcher main menu.
The following window will open to allow configuration changes:

Note that the modem’s ESN is displayed at the top of the window.

4. Use a radio button to select the NAM to make active.

5. To change a NAM entry you must delete the current value.  The entry is formatted
automatically and will not allow more characters than will fit the format.

6. The Home System ID will have been provided by your cellular carrier.

7. Use the pull-down menu to select the Side Preference dictated by your cellular service
provider.

8. The Description allows you to enter a text label to help you recognize the setting.

3.6. Monitoring CDPD With Watcher

To monitor the state of the modem’s CDPD connection, you can leave Watcher running all the
time.  The connection is established through Windows Dial-up Networking and Watcher is treated
as one socket to the connection.  Other Internet clients can be used simultaneously.

To monitor a CDPD connection:
1. Select Start > Programs > Watcher > Watcher – or double-click the Watcher icon.

The Watcher program window will open.

2. Ensure the modem is registered in CDPD mode.

3. Run other applications.

Watcher will receive event information from the modem and update the channel and signal
strength indicators (described below) when the modem advises of an event.  You can force
Watcher to update the display by selecting Window > Refresh from the Watcher main menu or
pressing F5 when Watcher is the active window.
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3.7. About the Watcher Program Window

The Watcher program window looks like this:

The window can be set to always be on top of other active windows by using the Window >
Always on Top option in the Watcher main menu.  Selecting the option again will disable the
feature.

The window can be minimized and the connection monitored by use of the icon shown in the
taskbar.

3.7.1. Icon Status

When Watcher is minimized, the shape of the icon shown in the taskbar indicates the current
operating mode and service status.

Indicates the modem is registered in CDPD mode.

Indicates the modem is unregistered in CDPD mode.

Indicates the modem is in Circuit Switched Cellular (CSC) mode.

Indicates the modem is in Wireline mode.

Indicates the modem is not responding.

3.7.2. Watcher Menus and Commands

The Watcher program window contains the following menus:

Settings Options Window Help

These are described below.
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3.7.2.1. Settings Menu

Any dimmed options are not available on the modem being used.

Wireline Switches the modem to Wireline mode.

Cellular Switches the modem to Circuit Switched Cellular (CSC) mode.

CDPD Switches the modem to CDPD mode.

Register Registers the modem on a CDPD network.

Set Radio Channel… Displays options for setting the radio channel automatically or manually.

Disable Transmitter Turns the transmitter off so the modem can only receive data.  When
selected a checkmark will appear beside it and the status line will indicate
the transmitter is disabled.  Select the option again to re-enable the
transmitter.

Exit Exits Watcher after gracefully shutting down any active modem connection.

3.7.2.2. Options Menu

Any dimmed options are not available on the modem being used.

Setup Watcher… Displays the dialog box for configuring the Watcher modem
connection and the startup strings for the wireline and CSC modes of
operations.  See 3.5.1 Configuring Watcher for details.

Setup Cellular… Displays a dialog box for configuring Circuit Switched Cellular
mode. You must be in Wireline or Circuit Switched Cellular mode to
select this command.  See 3.5.2.2 CSC Settings for details

Setup CDPD… Displays a dialog box for configuring CDPD mode. You must be in
CDPD mode to select this command.  See 3.5.2.1 CDPD Settings for
details.

3.7.2.3. Window Menu

Refresh F5 Updates the signal strength, and channel status indicators as
appropriate.

Always On Top Displays the Watcher program window on top of any currently active
application window.  When selected a checkmark will appear beside it.
Select the option again to disable the feature.

3.7.2.4. Help Menu

Pressing F1 will open the main Watcher Help window.  Other access to help features are:

Contents… Displays the main Help topics.

Search… Lets you search for keywords in Help.

Current… Opens Watcher Help to a context sensitive page.

Warranty Regisrtaion.. Displays a form for automated product registration via the Internet.

About… Displays important information about the Watcher version; the
modem version, EID, hardware and firmware revision, transmitter
temperature, and the connectivity drivers.
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3.7.3. Toolbar Buttons

The Watcher program window contains three buttons for selecting the operating mode, a button
for registering and de-registering your modem in CDPD mode.  These buttons are described
below.  If a button is dimmed, the option is not available on the current modem.

Click to switch to Wireline mode.

Click to switch to Circuit Switched Cellular mode.

Click to switch to CDPD mode.

Click to register the modem in CDPD mode.  When the cables appear joined, the
modem is registered.

Click the button again to de-register the modem.

3.7.4. Status Indicators

¡ Appears to the left of the Wireline button and indicates that Watcher is actively
communicating with the modem in a non-packet mode (Wireline or Circuit
Switched Cellular).

ll Appears to the left of the Wireline button and indicates that Watcher is actively
communicating with the modem in a packet mode (CDPD).

Shows the Received Signal Strength Indication (RSSI). Double-click on the
gauge to display the value in dBm.

 “---” (flashing) Indicates that the modem is not locked onto a CDPD channel.

Displays the current radio channel.

3.7.5. Updating Status Indicators

The display will refresh automatically when the modem reports an event.

To force an update of the status indicators, select Window > Refresh in the main menu or press
F5 when Watcher is the active window.  Depending on the operating mode, the status indicators
may take a few seconds to update.

3.7.6.  Quitting Watcher

To quit Watcher:
1. Click the close box in the top left corner of the Watcher program window.

Watcher may take a moment to close while it gracefully closes a CDPD session and disconnects
from the modem.
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3.8. Updating Modem Firmware

Should your modem(s) require a firmware upgrade, this section describes the procedure.

See Section 1.3 Currency for information on the current revisions at the time of this writing.  That
section also describes the method to determine the firmware revision on the modem.

When available, new firmware can be downloaded from the Sierra Wireless Internet site
(www.sierrawireless.com).  You may have the option to download a ZIP file (requiring either
PKUNZIP ver 2.04g or WINZIP v5.6) or a slightly larger self-extracting executable file.  Both of
the ZIP utilities are available from links on the Sierra Wireless download page.

To download the update:
1. Create a folder on your PC in which to store the download.

2. Click the chosen download link and save the file in the folder you have created.

3. If the ZIP file was downloaded then Unzip it using your extraction utility.

Before updating make sure you know which COM port your modem is connected to.  This
information is required by the upgrade utility.

To upgrade the Modem firmware, you can run either:
• SETUP.EXE program in Windows,

– or –

• INSTALL.BAT command file from DOS.

DOS firmware upgrade:

1. If you run the DOS option , EXIT Windows completely.

2. Change Directory to the one with the downloaded firmware.

3. Turn off the modem.

4. Enter INSTALL <space> d where d is the COM Port number.

Examples: INSTALL 1 (installs the firmware using COM 1)

INSTALL 3 (installs the firmware using COM 3)

5. Follow the Install instructions carefully.

Windows firmware upgrade:
1. Close all open applications.

2. Turn off the modem.

3. Run either the self extracting update file (which will expand and execute in one step) or the
SETUP.EXE file.

4. Select the COM port your modem is connected to.

5. You will be prompted to turn on the modem.  When you have done so, the installation
program will automatically perform the balance of the update.

Installation provides “thermometers” indicating the progress of the update.  These are only a
guideline.  Do not be surprised if the update completes before the indicators have been updated.

After the upgrade is complete you may delete the download folder or retain it for updating
additional modems, as you choose.

There are two elements to the firmware on the modems, bootstrap and application.  Not all updates
require replacement of both files.  If both files do need updating, treat each update separately and
perform all steps for each.  The boot firmware should be updated first.
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4. Basic Modem Operation

4.1. Introduction

This chapter provides some fundamentals to the operation of Sierra Wireless OEM modems and
some configuration elements of the host (DTE) to modem communication.  Important
considerations for wireless connections are covered here but specific techniques for setting up the
modem for various remote operations are provided in chapters on each mode of operation.

This chapter covers:
• Important terminology on modem modes and states.
• DTE / DCE communications link.
• Introduction to communication protocols and protocol stacks.
• Introduction to modem-to-modem handshaking and protocols.

4.2. Modem Modes and States

The SB320 modem supports multiple modes of operation and various states within each mode.
The other OEM modems only support CDPD mode but the states and conditions apply to them as
well.

The commands and registers used depend on the modem’s operating mode.  The state of the
modem and its condition also determine how the modem will behave in any given situation.

Depending on the product, the exact options available can differ.  If a mode or state is not
available on the product, commands related to those modes and states will return the ERROR
result code.

The modes, states, and conditions of the modem are described in sub-sections below.

4.2.1. Modes

The SB320 supports all of these modes while the SB30x family are CDPD mode only.

• Wireline – connected to the Public Switched Telephone Network (PSTN) using a cable
(usually with RJ-11 connectors).

• Circuit Switched Cellular (CSC) – connected to a cellular network using the Advanced
Mobile Phone Service (AMPS).

• Cellular Digital Packet Data (CDPD) – connected to a cellular packet switched data
network.  This mode requires use of an Internet Protocol (IP) stack, described below.

4.2.2. States

All modes support at least two states:

• Command – the modem exchanges data with the host (DTE) as AT commands and replies.
• Data – communication is passed between the host and remote terminal as computer data.

The modem’s state, in conjunction with its condition, will govern how the modem handles traffic
to and from the host and to and from a remote modem.
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4.2.3. Conditions

In addition to mode and state the modem can be in one of two conditions:

• On-line – actively connected to a remote terminal or with an active session in CDPD.
• Off-line – disconnected from any remote terminal or without an active session in CDPD.

While in off-line condition the modem can only be in command state.

In the on-line condition, the modem can be:
• In data state which passes data through the modem between the host (DTE) and the remote

terminal.
• In command state which exchanges data between the host (DTE) and the modem (DCE)

without passing it through the active connection to the remote terminal.

4.3. Modem Communications with the Host (DTE)

Communication between the host (DTE) and the Sierra Wireless SB300 Series modems is
currently fixed at:

bps: 19200
Data Bits: 8
Parity: None
Stop Bits: 1

Any application being used to issue AT commands must be configured this way.

Local flow control is implemented in hardware (RTS / CTS).

Autobaud support will be implemented in a later firmware release by April 1999 or earlier.

4.3.1. DTE Communication Options

As shipped the modem is configured with these settings:
• Echo enabled (E1) which causes the modem to echo characters received from the host back to

it while in command state.  The backspace is echoed as <backspace> <space> <backspace>.
• Quiet result codes disabled (Q0) which enables the modem to issue result codes following

commands.
• Verbose result codes (V1) provide results in English text appended with <CR><LF>.
• SB320 Speaker Control is set to be on until carrier detected (M1).

This setting means that a host running a terminal emulation program for communication with the
modem should have this configuration:
• Emulation – TTY
• ASCII character
Sending:
• No line ends with line feeds
• No local character echo
Receiving:
• Do not append line feeds to incoming line ends
• Do not force incoming data to 7-bit.
• Wrap lines if necessary

Commands may be entered in upper or lower case.

4.3.2. DTR Signal Handling

The modem can be configured to handle the DTR signal from the host in several ways.  The AT
command &D sets the method.  The factory default is to hang up any remote connection and enter
command state with auto-answer disabled (&D2).
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If you experience difficulty entering command state from a data state you may wish to have the
modem reset on DTR transition.

The available options are:

&D0 Ignore DTR

&D1 Enter command state without changing on/off-line condition.

&D2 Hang up and enter command state with auto-answer disabled.

&D3 Reset immediately (no reply is issued).  (SB320 only and not in CDPD)

4.3.3. DSR Signal Control

The SB300 Series modems will leave the DSR signal active whenever the modem is powered on.
There is no control of this signal.

4.3.4. Local Flow Control

The modems currently handle only hardware flow control (RTS/CTS).  This is the factory default
as well.  The SB320 in non-CDPD modes also supports the &K command to adjust this in future
firmware revisions.  The options are:

&K0 Disable local flow control

&K3 Use RTS/CTS hardware control

&K4 Use XON/OFF software flow control.  Don’t use this if these characters can be part of the
data stream.

There is also an impact to flow control with the use of the Communication Mode command (&Q)
available on the SB320 in non-CDPD modes.  This command effects the use of internal data
buffering at the modem.  If buffering is disabled, so is flow control.

4.3.5. Result Code Formats

The modems normally issue result codes on completion of an AT command.  This can be disabled
with quite mode (Q1).  The default is to issue results in verbose (English text) form.  Numeric
codes can be selected by disabling the verbose option (V0).

If echo is enabled (E1) the modem will append a <LF> to the echoed <CR> from the host.  If echo
is off, then there is no <CR> or <LF> prior to the response to the command.

Verbose result codes are returned with a trailing <CR><LF>.

Numeric result codes are returned with a trailing <CR> without the line feed.

Where the modem issues a response (data) prior to the result code, the response will have a <CR>
and <LF> appended regardless of the echo, quiet, and verbose settings.

A full diagram of the framing characters for both result codes and modem responses is provided in
the AT Command Reference (document 2110031) provided with the OEM Developer’s Toolkit.

NOTE:  Allow the modem a few seconds to respond to some commands.  Where mode changes
are involved the modem may require several seconds to reconfigure before responding.  On power
up, following initial internal configuration, the modem will issue the OK result code to the host
whether the host is actively receiving or not.



The Operational View                                                                                                            SB300 Series

Page 24 Proprietary and Confidential 2110059 Rev 1.0

4.4. Communication Protocols and Stacks

Data communication protocols are generally discussed in relation to the Open Systems
Interconnection (OSI) model.  The OSI model was introduced in 1978 as a long-term project of
the International Organization for Standardization (ISO).  It divides the communications process
into seven distinct layers, stacked one above the other, hence the term protocol stack.  This is very
different from the computer processing use of the term stack for a LIFO buffer.

Table 4-1: The OSI Model

Layer Description Common Protocols

7 – Application This is the window between the end-user
application and the communications process.  It
includes functions such as login and password
checks, and resource allocation.

Application programs
for file transfer,
e-mail, etc.

6 – Presentation Responsible for terminal management such as
character set interpretation (i.e. ASCII, ANSI) and
code conversion.

5 – Session Session management includes data-flow
synchronization, mapping addresses with names,
handling graceful and abrupt disconnections, and
data buffering.  This layer organizes data into
Session Protocol Data Units (SPDUs).

Telnet, FTP, SMTP,
etc.

4 – Transport Transport Protocol Data Units (TPDUs) are
assembled at this layer.  This can include
multiplexing and demultiplexing, error detection
and recovery, and packet reordering where the
network can receive packets along different routes
which can arrive out of sequence.

UDP, TCP

3 – Network Data is organized into packets which are data
frames with network headers and trailers added
including network addressing.  The duties include
flow control, handling network service data units,
notifying the transport layer of errors, and possibly
sequenced delivery.

IP, SLIP, PPP

2 – Link This layer arranges the bits into frames.  It also
establishes and releases one or more link
connections.

Network Interface
Cards, Modems

1 – Physical This is the physical connection layer concerned
with carrying the communication of digital data.

Transmission Media:
Twisted Pair, Fibre
Optics, Cellular
Radio, etc.

4.4.1. SB300 Series Internal Protocol Stacks

The SB300 Series modems are designed to provide the bottom two layers, Link and Physical.  The
modem will handle acquiring a telephone line or cellular channel to provide the physical
connection.

In CDPD mode, the SB300 Series modems are also capable of supporting the next two layers at
the user’s option.  Both UDP and TCP Packet Assembly/Disassembly (PAD) services are
available along with IP and SLIP network support.  The modems do not currently support PPP but
it will be implemented in a later firmware release by April 1999 or earlier.
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CSC and Wireline modes require that the host system provide the protocol stack for layers 3 and
above if they are needed.  Windows Dial-up Networking can provide the TCP/IP stack.  Other
Windows-based Internet clients can provide the higher layers for file transfer, e-mail, and other
services.

4.5. Modem Handshaking (SB320)

For two modems to communicate with each other, it is imperative that they speak the same
“language”, i.e. they use the same protocol(s).  CDPD establishes a single protocol for its
communications, but CSC and Wireline modes can use any of several protocols.  The following
discussion is for users of CSC and Wireline modes on the SB320 modem.

Because of the variety of protocols that are available for modem communications, a modem will
usually support several protocols to enable it to connect to a variety of modems.  In the process of
a modem establishing a connection with another modem, there will be a negotiation phase during
which the two modems exchange basic information to determine which protocol(s) shall be used
for the present connection.

If the modems can agree on a communication scheme using one or more of their available
protocols, they will proceed to establish a connection.  At this point, the modems are ready to pass
data to their respective DTEs where the application software runs.  If the modems fail to agree on
a communication scheme due, for instance, to the lack of a common protocol, the connection
attempt is aborted and the modems disconnect, or go on hook.

4.5.1. Modem Protocol Layers

The communication protocols used by modems can be divided in 3 categories or layers as shown
in the figure below.  Each layer operates independently of the layer above it.  A modem
connection may be established using one or more of these layers, starting from the lowest layer
and including more layers as required by the situation.

Local Modem Remote Modem

Data Compression
(V.42bis, MNP5)

Error Control
(LAPM, MNP2-4, MNP10)

Data Communication
(V.34, V.32bis, V.32, ...)

Data Compression
(V.42bis, MNP5)

Error Control
(LAPM, MNP2-4, MNP10)

Data Communication
(V.34, V.32bis, V.32, ...)

Receive Data

Transmit Data

Figure 4-1:  Modem Protocol Layers

4.5.1.1. Data Communication

The lowest layer is that which is closest to the hardware and it deals with the modulation scheme
used to transmit and receive the raw data that is presented to the layer above.

This layer, which we will call the data communication protocol, has many available standards:
V.34, V.32bis, V.32, V.22, etc.  It is concerned mainly with establishing the modulation scheme
that will give the highest baud rate (bps) on a given physical point-to-point connection.
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The more advanced protocols, such as V.34 for example, are smarter in that they are capable of
simultaneously supporting different rates on the transmit and receive lines, and allow two modems
to exchange information to fine-tune their modulation parameters to optimize performance.

4.5.1.2. Error Control

The next layer is the Error Control Protocol Layer which implements one of a number of error
encoding and detection schemes on outgoing and incoming data frames respectively.

By appending extra encoding bits to outgoing data packets, it allows the receiving modem using
the same Error Control protocol to check whether the data has been corrupted during transmission
and demodulation by the lower layer.  Similarly, it processes data frames received from the other
modem by using the appended encoding information to check for corrupted data.

In addition to error coding and detection, this layer also takes care of the retransmission of
corrupted packets to ensure that data delivered to the layer above it is error free.

This layer is also provided in several standards: LAPM, MNP2 through 4, MNP10, etc.

4.5.1.3. Data Compression

The third layer is the Data Compression and Decompression Protocol.  On outgoing data, this
layer effectively reduces (or compresses) the number of bits coming from the application layer
above it to a smaller number of bits without losing any information.  The receiving modem then
decompresses this data and reconstructs it to its original form.

Considering that the slowest link between two modems is always the wireline or cellular link, this
scheme reduces the amount of data flowing on that link and consequently increases the overall
data throughput.

This layer is implemented by a variety of protocols, two of the most widely used ones being
V.42bis and MNP5.

4.5.2. CSC vs. Wireline

Older modem protocols, such as V.32 and earlier, were developed and optimized for PSTN
wireline networks.  However, with the advent of cellular phone networks, and the need for
wireless modems to operate within these networks, it became apparent that some adjustments had
to be made to the existing protocols to enable them to achieve performance similar to their
wireline counterparts.

4.5.2.1. Enhanced Throughput Cellular (ETC)

ETC was developed to bring cellular link performance up to wireline levels.  Although it does not
exist as a layer of its own, it interacts with various layers by adjusting some of their critical
parameters to compensate for network differences.  It uses a number of techniques to improve the
robustness of the data link.

At the lowest layer, ETC adjusts the filter characteristics which modulate and demodulate the
carrier signal to compensate for differences between PSTN and cellular networks.  At the Error
Correction layer, it enforces the use of small data packets so that retransmissions are short in the
event of data corruption, which will be more frequent in a wireless environment.

Because ETC does not exist as a separate layer in the stack shown above, but instead makes use of
existing protocols, it is possible for an ETC-enabled modem to communicate with a non-ETC
modem.  Although it is preferred that both sides of the modem link support ETC, one of the
attributes is that even if only one side supports ETC, significant benefits will be gained.

Also, due to the nature of ETC making use of existing protocols, ETC imposes certain constraints
on which protocols must be present at both ends for a connection to be established.  The required
protocols are LAPM for Error Correction and V.42bis for Data Compression.  Without these on
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the receiving modem, the ETC modem will not be able to negotiate a connection and will
disconnect; irrespective of what other protocols the modems may have in common.

ETC includes the following specific settings to improve immunity to the interference and noise
effects mentioned earlier.
• Small frame size
• Do not allow non error-corrected links,
• Wait for carrier 90 seconds
• Lost carrier hang-up set to 10 seconds

Use of small frame size does reduce direct throughput by 10%, but gives a more robust
connection.

The policy of “start slow and train up” guarantees that the initial negotiation phase has more
chance of success.  Start-up speeds of 4800 bps and 9600 bps may be used.  In addition if a
connection has not been established after 60 seconds, the modems will fall back to 1200 bps.

Even with all this it is best to limit the maximum DCE speed.

4.5.2.2. Modulation

High speed modem protocols such as V.34 and V.32 use a technique known as Quadrature
Amplitude Modulation (QAM).  QAM operates by modulating a carrier sine wave signal in both
amplitude and phase.  Each unique combination of amplitude and phase is known as a ‘symbol’
and, therefore, each symbol represents a number.  If there are 8 symbols (i.e. 8 unique
combinations of amplitude and phase), then each symbol corresponds to a unique 3-bit number
(0b000 to 0b111).  On the receive side, the reverse process of demodulation is performed on that
modulated carrier signal and the symbols or bits of information are retrieved.

The key to achieving high speed on a modem is to use as many symbols as possible so that more
bits can be encoded in them.  The number of symbols that can be used is determined by the
receiving modem’s ability to resolve or distinguish between these various symbols.

The more symbols there are, the more difficult it becomes for the modem to resolve them.  This is
because there is always a certain amount of noise on the link which causes the symbols to appear
“fuzzy” on the receive side.  The receiver can mistake one symbol for another.  This is where the
protocol speed training algorithm comes into play.  It is constantly measuring the amount of noise
on the line and based on that measurement will select a speed where it knows it will be able to
resolve symbols reliably.  In other words, the modem speed is a function of noise level.

Note that “noise” here is not just noise in the traditional sense of the word, such as white noise,
crackle, etc.  It also includes distortions of the carrier signal caused by the various filtering stages
present between the two modems, starting at the transmitting modem itself, all the way through the
cellular network, the PSTN network, and finally the receiving modem.

Because cellular networks optimize their system for voice, additional distortions are created which
result in a higher noise figure and hence lower speed.  ETC attempts to counteract these cellular
network distortions at both the transmit and receive ends.

The smarter protocols such as V.34 implement adaptive filtering techniques where the filter
characteristics are constantly adjusted to produce the lowest noise figure on both the transmit and
receive channels.  V.32bis and lower speed protocols are not as sophisticated in that they will not
adapt to any situation.  This is why a V.34 modem will achieve higher speeds than a V.32 modem
in a given environment.

The SB320 modem is capable of establishing both ETC and non-ETC connections while in CSC
data mode.  The fastest protocol supported by the SB320 is V.34.  This means that the highest
speed theoretically achievable with this modem is 33600 bps.  However, this occurs under ideal
conditions as found typically in a PSTN wireline environment.  In a cellular network, experience
shows that it is quite rare for such speeds to be achieved.  Instead, speeds of up to 19200 bps are
more typical, depending on the characteristics of both the cellular and the PSTN sections of the
link between two modems.  Common connection rates are 9600 and 12800 bps.
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The table below shows the fall back speeds from V.34 to V.22 as supported by the SB320 modem.
When ETC is enabled on the SB320 using the “super” AT command AT&F5 (described in the
CSC Operations section), the maximum speed of the modem is limited to the DTE speed (set at
19200 bps).

Protocols Speed (bps)

V.34 19200 - 33600

V.32bis 14400 - 12000

V.32 9600 - 4800

V.22bis 2400

V22 1200 – 600

4.5.2.3. Configuration Issues

Using an SB320 in Wireline or CSC modes requires careful use of the AT commands that tune the
various elements controlling modem handshaking process.  Optimizing for Wireline and CSC
modes requires different settings.  Where one mode is improved with a particular profile or
settings, the other can be impaired by the same profile.

The specific sections on CSC and Wireline Operations (Chapters 6 and 7 respectively) give a
description of some of the key AT commands and S-registers associated with performance so that
the user can modify the modem configuration from its default settings if necessary.
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5. CDPD Operation

This section provides information on configuring and using the modem in CDPD mode if you are
not using Watcher and Windows Dial-up Networking for your connections.  If you are using a
standard Windows-based application then consult Section 3.3 Configuration using WirelessExpert.

The introduction provides some background on CDPD communications in general.

5.1. Cellular Digital Packet Data (CDPD) Introduction

CDPD is a wireless radio frequency (RF) packet switched data communications service which
provides two-way, fully digital, 19.2 kbps packet data networking services to mobile hosts.  All
data is exchanged with the network in the form of IP packets (TCP or UDP).  It is simply a
wireless extension of traditional networks, providing the user with seamless access to data
applications on these networks.

Instead of using a dedicated cellular channel or telephone line to transmit data, CDPD devices,
like the Sierra Wireless modem, are able to send data over cellular voice channels (the airlink)
during the time periods when these radio channels are not used for standard cellular voice
communications.  When a channel becomes overloaded or used by a cellular voice call, the CDPD
devices “hop” to an unused or idle channel.  Since this initial design implementation, many areas
now dedicate specific channels to only CDPD traffic.

With multiple mobile devices sharing the cellular channel, data transfer rates can vary depending
on channel loading.  Maximum data rates in the order of 1000 characters per second (10 kbps) are
achievable only under lightly loaded ideal conditions.

The cellular radio channel is only used when actual data is being sent or received and not when the
user application is idle.  This contrasts with CSC mode which “owns” the connection channel as
long as the connection is open.  CSC consumes the cellular resource even when the application is
not actively communicating.

CDPD provides the following airlink support:
• Compression of packet header and information fields transmitted over the wireless channel to

reduce the amount of the airlink resource used.
• Support of many users on the same cellular RF channel at the same time.
• Error correction of data sent over the airlink.
• Movement of the user from one cell site to another.
• Delivery of properly sequenced data between user applications over the airlink.

The CDPD network operates as a collection of CDPD service provider networks, with the service
provider networks being operated by cellular carriers who provide services such as:
• Data connection to other networks
• Application services
• Network management
• Network security
• Accounting and billing

5.1.1. Security

With data exchanged over a broadcast radio link, security is required to prevent eavesdropping.
Airlink security is automatically provided by encrypting the data packets between the SB300
Series modem and the service provider’s Mobile Data Intermediate System (where the radio signal
is routed to a wireline public or private data network).  If end-to-end data security is desired it
must be implemented or otherwise provided by the end-user.



The Operational View                                                                                                            SB300 Series

Page 30 Proprietary and Confidential 2110059 Rev 1.0

5.1.2. Architecture

The major cellular carriers and equipment manufacturers created a trade group called the Wireless
Data Forum (formerly the CDPD Forum), that develops and publishes the governing technical
specifications for, and promotes the use of CDPD technology.

The CDPD network provides a Connectionless Network Service (CLNS), one in which the
network routes each packet individually within the network based on the destination address
carried in the packet and knowledge of the current network topology.  It is often referred to as a
datagram service.  From the user’s point of view, only the destination address is known, since the
CDPD network manages the packet routing required to reach the destination.

5.1.3. Modem Registration

5.1.3.1. The Network Entity Identifier (NEI)

Each user on the CDPD network is identified by a distinct Network Entity Identifier (NEI) which
is used by the CDPD network to route messages to the user.  This is like an account on the
network.

Each NEI has a single home subdomain, where it is normally expected to be located within the
network.  For example, a user’s home may be Las Vegas.  Each modem may support more than
one NEI, each of which has a home subdomain, which may or may not be the same.

For example, you may wish to have three NEIs for the same modem; with these NEIs having
home subdomains in Las Vegas, New York, and Dallas (cities to which you travel regularly).  You
may want to use the NEI corresponding to the city you are currently in.  Alternatively, you may
want to support two separate NEIs that have the same subdomain, such as one for business use and
the other for personal use.

You may travel from a subdomain registered as the home area to a new serving area.  The mobility
management functions provided within the CDPD network handles the routing of packets for
visiting modems in a manner that is transparent to you.  If you have pre-arranged with your service
provider, you may obtain service in a serving area supported by another service provider.

The NEI used in the Sierra Wireless modem is the address assigned to the subscriber by the CDPD
network service provider.  IP Addresses are 32-bit numbers that uniquely identify a given machine
(or end system) running the TCP/IP protocol suite.  You need to have a unique address before you
can link in with the rest of the networked world.

The NEI for the Sierra Wireless modem may be installed using the WirelessExpert application
provided with the modem.  Up to four unique NEIs can be supported in the Sierra Wireless
modem.  The CDPD service provider will have a unique Service Provider Network Identifier
(SPNI).  The CDPD service provider must supply the SPNI in numeric format to the CDPD
subscriber if you wish to restrict the modem to using that provider.  The WirelessExpert
application can be used to enter SPNIs into a table of accepted providers.

5.1.3.2. Equipment Identifier (EID)

One parameter that the CDPD service providers require from the CDPD subscriber registering
their modem is the Equipment Identifier (EID).  The EID is unique to each modem.  Essentially, it
represents a unique electronic serial number for the subscriber device.  No two devices in CDPD
can have the same EID.

The format used in representing this 48-bit EID is hex bytes separated by hyphens (e.g., 00-A0-
D5-00-00-7B).  This is programmed into each Sierra Wireless modem at the factory, and the
subscriber can view the EID at any time using the Watcher or WirelessExpert applications
supplied with the modem, or the AT command AT+WPEID.

When a user initially signs up for service with a CDPD service provider, they will be required to
provide the service provider with the EID.  This EID then becomes part of the CDPD Subscriber



User’s Guide                                                                                                                           CDPD Operation

2110059 Rev 1.0 Proprietary and Confidential Page 31

Directory Profile maintained for each subscriber on that CDPD network by the CDPD service
provider.

5.1.3.3. Authentication

Each NEI (network account) is mated to an EID (modem device).  One NEI cannot be used with
different devices (EIDs).  One device (EID) can have more than one associated NEI (account).

One of the functions performed by the CDPD network is NEI authentication and verification.
This service provides corroboration to ensure that the source of the data received from a user is as
claimed and not from a cloned CDPD subscriber device.  In other words, only the authorized
owner of the NEI (the modem) is using the NEI.  As a result of this authentication procedure,
once a user has registered an NEI and a modem, they cannot use that NEI for data
communication over the CDPD network on a new or different modem.

If you replace or change modems, you must contact your service provider to reset your network
credentials before you can use the new modem.

5.1.4. CDPD Radio Coverage

The subscriber should obtain information from the service provider about what CDPD service
coverage is available in the required areas.

In most cases, the subscriber will not be aware of the quality of service provided over the CDPD
airlink.  Watcher does provide a feature that gives the user an indication of the airlink quality for
their Sierra Wireless modem.  This quality metric is based on the strength of the signal that is
being received by the modem.

Received Signal Strength Indication (RSSI) is a measure of the strength of the RF signal received
by the modem.  It is expressed either by an analogue thermometer or a logarithmic scale, in
decibels relative to one milliWatt (dBm).  A strong signal level has a less negative number (i.e., -
50 dBm) and a weak signal level has a more negative number (i.e., -100 dBm).

The CDPD service provider attempts to ensure that the signal level is fairly strong throughout the
coverage area (i.e., -80 dBm or stronger), but due to shielding of the signal by man-made
structures, the signal may be less than this desired value.

Examples of locations where a signal could be weaker than desired is in underground parking
garages, tunnels, buildings with all metal construction, old concrete buildings with large amounts
of steel reinforcing bars, etc.  In such cases, the CDPD subscriber may be able to get a stronger
signal by locating the antenna near an opening or window.  The effect of this repositioning on the
RSSI can be observed in the signal strength window of the Watcher application.

5.1.5. CDPD and the SB300 Series Modems

The role of the Sierra Wireless modem in CDPD mode is:

1. Accept commands and digital data from the end-user application equipment (DTE) through
the serial connection.

2. Assemble the data into packets.

3. Encrypt the packets.

4. Transmit the encrypted data packet to the network.

5. Receive packet data from the network.

6. Decrypt the packets.

7. Disassemble the packets to extract the application data.

8. Pass the serial data to the end-user’s application equipment.

Note that the built-in encryption is for the airlink only (between the modem and the cellular
service base station).  If end-to-end data security is desired it must be implemented or otherwise
provided by the end-user.
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The extent to which the packet data is assembled and disassembled by the modem is determined
by setting the CDPD packet service mode to use SLIP, UDP, or TCP.  Use of these protocols is
discussed later in this section.

5.2. Configuring NEI Entries

In order for the modem to register on a CDPD network it must have a unique Network Entity
Identifier (NEI).  This is an Internet Protocol (IP) address assigned by your CDPD network service
provider.  Section 2.2.1 CDPD Registration contains information on activating this service.

The service provider must assign you an NEI and channel side preference.  They should also
provide their Service Provider Network Identifier (SPNI) number.  To do this, the service provider
will need to know the Equipment Identifier (EID) of the modem which can be reported by the
modem by issuing the +WPEID command.

This information is recorded within the modem either by using the WirelessExpert configuration
program or through direct entry using AT commands.  To use WirelessExpert please consult
Section 3.3.

If you need to access web sites on the Internet, a Domain Name Server (DNS) address is also
required.  The modem does not manage this layer of the Internet connection but WirelessExpert
will record the DNS address in the Windows networking facility for use at the application level.

5.2.1. NEI Table

The modem can store up to four NEIs.  One of these is the active NEI entry.  The active entry is
the one on which most NEI related commands act.  It can be different from the auto-register NEI
or a currently registered NEI.  The active NEI is indicated by an index pointer stored in register
+WS197.

Although it is recommended, it is not necessary to de-register from the CDPD network before
making changes to the table.  If you alter the NEI entry that is currently registered, the modem will
de-register the old value.  If auto-register is enabled, the modem will then attempt to register the
new one.

Note that CDPD credentials are associated to the table entries.  You cannot re-arrange the NEIs in
the table without resetting credentials with your cellular service provider.

5.2.1.1. NEI Configuration With AT Commands

To store the NEI and related CDPD activation parameters using AT Commands enter the
following commands (the AT is omitted for brevity):

1. +WPNEILIST to display the NEI table and indicate if one is registered.  The auto-register
NEI is indicated with an asterisk (*) but the active NEI is not indicated.

2. +WS197=n where n is the entry you wish to edit (1 through 4).  This will make it the active
NEI.

3. +WPNEI=ip where ip is the NEI address to assign.  You do not need leading 0s in the
individual elements of the address.  When you press <enter> the modem will respond with a
prompt to confirm the change in the table.  The old and new values are both shown.
Press Y (case insensitive) to confirm the change, or
Press N (or any key other than Y) to cancel the command.

The modem will respond with OK if the NEI is in a valid IP form.

4. +WPNEILIST to display the list and verify the new entry.
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5. +WS174=n where n indicates the channel side preference.  Values are:
0 – A side preferred,
1 – B side preferred,
2 – A side only,
3 – B side only.

NOTE that this preference is stored in a register not associated with a particular entry in the
NEI table.  The preference will be used for all NEI registrations.

5.2.2. SPNI Matching

If you want to restrict the modem to only using channels belonging to a particular list of service
providers you can enter a table of SPNI values.  When the modem is finding a channel, it will
check the SPNI of each channel against entries in this table.  If there is no match, the modem will
reject the channel and continue searching.

If the table is empty, the SPNI matching feature is disabled.

NOTE:  If you set SPNI matching and also use +WPCHAN to assign a channel manually, the
assigned channel will not lock if the SPNI fails to match.  The modem will not be able to register
because it will not look for another channel if you have manually set a channel.  The channel lock
can be checked using +WPRSSI.

5.2.2.1. SPNI Table Configuration

To manage the use of SPNI matching using AT Commands enter the following commands (the
AT is omitted for brevity):

Read the Current SPNI Table
1. +WPSPNI? Displays the SPNI Table.  If the table is empty then SPNI matching is disabled.

If there is at least one entry then SPNI matching is enabled.

Disable SPNI Matching
1. +WPSPNI=  By not entering parameters, the table will be erased.  An empty table disables

SPNI matching.

Enable SPNI Matching
1. +WPSPNI=n[,n[,…n]]  where n is a SPNI value and multiple values are separated by

commas.  The list of parameters provided will replace any previous table.  You cannot append
entries to an existing table.  You may enter up to 10 values in the table.  By entering one or
more SPNI values, the SPNI matching feature is automatically enabled.

5.3. CDPD Network Registration

Note that network registration must be performed before communication across the network can
begin.  Registering on the network is distinct from opening a session.  Registration simply
confirms a connection to the network as a whole and authenticates your modem’s credentials.
Data Carrier Detect (DCD) is tied to sessions not network registration.  A session does not begin
until you originate a session (client) or auto-answer one (server).

The modem can be set to register manually (on command) or automatically when it enters CDPD
mode.  The NEI address used for registration is determined differently for each method.

The mode of registration is set in register +WS173 (Registration Mode).  A value of 0 indicates
manual registration and 1 indicates automatic.  The modem is shipped with a value of 1 but the
modem will always default to the last method used.  Restoring settings with &F (factory) or
Z (user profile) will NOT restore a setting to this register.

For WirelessExpert to work, the modem must be set to automatic registration.
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5.3.1. Active and Auto-register NEI Indices

The modem keeps two separate index entries to the NEI table.  These indices have an intricate
inter-relationship that you should understand.

Auto-registration uses the index at +WS176 (Auto-register NEI Index).  Manual registration and
manipulation of the NEI table are based on an index at +WS197 (Active NEI Index).

When the modem registers an NEI, the index of the NEI used (manually or automatically) will be
stored in the Auto-register NEI Index (+WS176).  This means that auto-registration will always
use the last registered NEI unless the Auto-register NEI Index is changed while the modem is de-
registered in manual (+WS173=0) mode.

Changing the setting in the Auto-register NEI Index while the modem is registered causes the
modem to de-register the old NEI address.  This happens in both manual and auto-register modes.
If the modem is set to auto-register (+WS173=1) then the modem will go on to attempt to register
the new NEI.

Register +WS197 (Active NEI Index) is quite independent of any currently registered NEI and
can be changed freely.  This allows access to other table entries while registered without affecting
the registration status.

The manual registration command (+WPREG) will use the Active NEI Index (+WS197) as the
address to register.  It will also store the value of the Active NEI Index (+WS197) into the Auto-
register NEI Index (+WS176) so that it becomes the default address for future auto-registration.
This copying of the index takes place even if the manual registration fails.

In summary, the Auto-register NEI Index value will follow the Active NEI Index value if there is
an attempt to register manually.  The Active NEI Index can change freely and is not influenced by
changes in the Auto-register NEI Index.

5.3.2. Manual Registration

When the modem is set for manual registration (+WS173=0) it will not attempt to locate a CDPD
channel until commanded to register (+WPREG) or the command to set a channel (+WPCHAN)
is set to 0 (automatic selection).  You may select a channel first if desired.  If you do not assign a
channel, or if you force automatic channel selection by setting +WPCHAN=0, the modem will
scan for one when the registration command is issued.

5.3.2.1. Select a Channel

If you assign a channel, the modem will use that channel for registration attempts.  If registration
fails on the assigned channel NO automatic attempts are made to locate another channel.

NOTE:  If you set SPNI matching and also use +WPCHAN to assign a channel manually, the
assigned channel will not lock if the SPNI fails to match.  The modem will not be able to register
because it will not look for another channel if you have manually set a channel.  The channel lock
can be checked using +WPRSSI.

Assign a Channel

To assign a channel for use by the modem issue the AT command +WPCHAN=n where n is the
channel number to assign.  The modem will go to that channel.  Subsequent use of +WPRSSI will
report the strength of signal and if the channel has been acquired.

Changing the channel assignment while the modem is registered will not change the registration
status.  The modem may lose connectivity if the new channel does not present sufficient signal.

Where the cellular carrier forces CDPD channel hopping the modem will follow the hops
regardless of the user assigned channel.
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Auto-locate a Channel

To have the modem locate a channel, issue the AT command +WPCHAN=0.  The modem will
then scan for a channel when requested to register (or auto-register).  RSSI requests will reflect the
status of the channel found.  The channel number will also be available by querying register
+WS200 (Current Channel Number).

5.3.2.2. Register Manually

To register an NEI manually:

1. +WS197=n where n is the index to the NEI you wish to register.

2. +WPREG to register the NEI.  If the NEI is already currently registered the modem takes no
action and returns the registration result code.  Otherwise, the modem will:

• De-register any currently registered NEI
• Locate a channel if necessary
• Attempt to register the NEI and authenticate credentials

The modem will terminate the process on one of three conditions:
• Success – The modem will report the Registered result code.
• Failure – The CDPD network failed to register the NEI for reasons given in the result code

(i.e. INSUFFICIENT_CREDENTIALS).
• Time-out – The register +WS198 (Registration Wait Time) allows settings from 1 to 255

seconds (default 30) for the registration process.  If this time elapses without successful
registration the modem will return the Timeout Expired result code.

5.3.3. Automatic Registration

The modem can be set to register the NEI indexed by +WS176 (Auto-register NEI Index)
automatically.  Register +WS173 (Registration Mode) controls this feature.  When this register is
set to 1 the modem will immediately attempt to register and will subsequently attempt to register
automatically on entry to CDPD mode (startup on CDPD only modems).

Automatic registration will retry indefinitely should attempts fail.

Setting the Registration Mode to 0 will de-register the current NEI if it successfully auto-
registered earlier.

5.3.4. De-registration

The modem will de-register on any of several events.

If the modem is in manual registration mode it will de-register if:
• The De-register command (+WPDEREG) is issued for the registered NEI.  Note that this

command will reference the NEI indexed by register +WS197 (Active NEI Index).  It is
possible that this register has been changed (by command) after an NEI was registered and no
longer points to the registered entry; in which case, the registered NEI remains registered and
no action is taken by the modem.  The Active NEI Index must point to the registered address
for this command to work.

• The registered NEI is overwritten with a new value using +WPNEI=.

If the modem is in automatic registration mode it will de-register if:
• The registration method is changed to manual (+WS173=0).
• The value of the Auto-register NEI Index (+WS176) is changed.
• The registered NEI is overwritten with a new value using +WPNEI=.
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5.4. Monitoring the Network Connection

Prior to finding a channel, many query items will return 0.  Once locked onto a CDPD channel, the
modem can provide several pieces of information about the connection.  Additional information is
available regarding the registration of the modem.

5.4.1. Radio Signal Monitors

5.4.1.1. Signal Strength

There are two primary monitors of signal strength.

A “percentage” value can be read from register +WS50 (Normalized Signal Strength).  It reports a
value from 0 to 100 where 0 is imperceptible and 100 is full signal.

The Receive Signal Strength Indication (RSSI) is more informative.  It is read with the RSSI and
Channel State command (+WPRSSI).  It reports:
• Signal strength in dBm (-113 to -30),
• State of the channel (1 - Scanning, 3 - Acquired, 4 - Sleeping),
• Registration Status (0 no, 1 yes)
• Channel number (0 if scanning)

Note that the registration status reported here is that of the Active NEI Index (+WS197) which
may point to a NEI other than one that is in fact registered.  Consult register +WS56 to check the
registration status of the modem.

5.4.1.2. Current Channel

The channel number is available from register +WS200.  A value of 0 indicates the modem has
not acquired a channel.

5.4.1.3. SPNI of the Connected Carrier

When the modem has locked onto a channel (whether registered or not) the Service Provider
Network Identifier (SPNI) for that channel can be read with the command +WCID.

5.4.1.4. Cell Number

Although not important in most circumstances, the number of the current CDPD base station is
available from register +WS210.

5.4.2. Registration Status

The status of the modem’s registration can be read at register +WS56 (Network Registration
Status).  A value of 1 indicates the modem is registered.  A value of 0 indicates that it is not
registered.

5.4.2.1. Registration Mode

The current setting of auto-registration is found in register +WS173.  A value of 1 indicates
automatic registration is enabled, 0 indicates manual registration mode.
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5.5. Sleep Mode

CDPD provides a facility to allow modems to go to “sleep” when they do not have active
communications.  This allows the modems to shut down hardware to reduce power consumption.

When the modem is waiting for data from either the host or network end, it does not need to keep
all hardware systems running.  The CDPD network sends a periodic message to registered IP
addresses to advise if there is pending traffic on the network for them.  The modem can be
programmed to shut down the receiver (go to sleep) between these messages, and wake up at the
defined intervals to check if the network has traffic.  If there is no pending traffic, then the receiver
can go back to sleep until the next scheduled notification message.

The SB300 Series modems can use this feature and have added an additional feature called “logic
sleep” to further reduce power consumption.

5.5.1. CDPD Sleep

This is what is meant by the general term “sleep” mode.  It is controlled by setting register
+WS175 (CDPD Sleep Idle Time).

Setting the register to 0 (zero) will disable sleep mode.  The modem will keep the receiver active
for immediate handling of any incoming traffic from the network.

Sleep is enabled by setting the register to the time in seconds, from 10 to 3600 (1 hour), during
which the modem must have no traffic.  Provided there is no traffic to or from the network during
that interval, the modem will begin using CDPD sleep.

Once sleep mode is engaged, the modem logic will turn off the radio receiver.  It will turn on the
receiver at the intervals prescribed to check for traffic.  If there is traffic, the modem will then deal
with it.

The disadvantage to sleep mode is that traffic from the network will have to wait up to a
maximum of one minute for the next notification cycle before the modem can receive it.  This can
slow down response in some time critical applications.

While sleeping, the modem logic is ready to receive data from the host at any time.  The modem
will immediately wake up for host generated traffic.

5.5.2. Logic Sleep

In addition to switching off the radio for CDPD sleep, the modem can be placed in a logic sleep
mode.  This further reduces the power consumption of the modem.  Logic sleep will not engage
unless CDPD sleep is already engaged.

Logic sleep will automatically engage (if it is enabled) when the modem is inactive.  This can
engage after executing an AT command and before the next command is issued.  The modem can
also go into logic sleep while in auto-answer mode.  The modem will wake-up periodically as part
of the CDPD sleep operation to check the network for messages.  Incoming data amounts to a
RING when auto-answer is enabled, so the modem will be awake to receive messages.

This feature is controlled with register S31 (Logic Sleep).  Setting the register to 0 (zero) will
disable logic sleep.  Setting it to 1 will enable normal logic sleep.  In this condition the modem
will reduce power until the host sends a command or CDPD sleep operation requires activity.  It
will wake as soon as a character arrives from the host, or automatically as needed to make periodic
network checks for traffic.

Setting the Logic Sleep register to 2 will enable deep-sleep.  This will cause the modem to shut
down even more hardware, conserving even more power.  The disadvantage to this is that the
modem will lose the first incoming character from the host (DTE).  In fact, the modem will take
80 milliseconds, from the start of the first incoming character, to wake up.  The host must be
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aware of both the wake-up delay and that the first character to the modem was lost.  Automatic
wake-ups to check the network will still occur so no incoming network traffic is lost.

5.6. Friends Only

Friends Only is a feature available when either the UDP or TCP PAD is enabled in a server
session, but is not used with the SLIP protocol.

Friends Only permits reception of packets to be restricted (for security reasons) to a predefined
group of IP addresses (friends).  Friends Only mode is controlled by entering IP addresses in a
Friend Only table.  If the table is not empty, the feature is enabled and the comparison of packet
source addresses against the list stored in the modem will be made.

This subject is discussed in further detail in both the UDP and TCP packet services sections
below.

5.7. Packet Services

SB300 Series modems support three connection protocols in CDPD:
• SLIP (PPP is coming in a future firmware release)
• UDP PAD
• TCP PAD

The modem’s packet service is set in register +WS45 (Packet Service).  This setting can be made
before or after registration on the network.  It should not be changed once the modem starts a
session (is on-line).  If a change to packet service is required, the user must close the current
session (go off-line), change the setting, and then establish a new session.

Use of each of the services is described in sub-sections below.  For more on protocols generally
see Section 4.4 above.

5.7.1. Serial Line Interface Protocol (SLIP)

SLIP is one method for encapsulating packet data over dedicated and/or switched serial lines.  It is
a useful and reliable way to allow mixes of hosts and routers to communicate with one another in
various combinations.

When operating in SLIP mode, the modem’s internal Packet Assembly / Disassembly (PAD)
services are bypassed and the modem acts as a router passing data between the host’s protocol
stack, and the CDPD network.  All protocol headers are the responsibility of the host as is the
SLIP framing to the packets.  The modem will parse the SLIP frame character to distinguish
packets and to identify the data state escape sequence.

This protocol is useful if the host application must have multiple sessions active concurrently.  An
example would be a police car, which may need simultaneous connections to a local dispatcher, a
state motor vehicle bureau, and a federal database.

Note that the SLIP protocol does NOT support auto-answer.  If the modem was in auto-answer in
another packet service, it will be turned off (S0=0) when SLIP is selected.  Attempts to set the
auto-answer register (S0) to a value other than 0 will return the ERROR result code.

5.7.1.1. Opening a SLIP Client Session

A detailed discussion of a SLIP session follows the outline of steps to open a SLIP Client Session.
(AT is omitted for brevity):

1. +WS46=4 to place the modem in CDPD mode (only required on the SB320).

2. +WS45=3 to select SLIP service.

3. Optionally assign a channel with +WPCHAN=n where n is the channel to use.
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4. Optionally verify the channel acquisition with +WPRSSI looking for the second value in the
return string to be 3.

If the modem is using auto-registration (+WS173=1) skip to step 7.

5. +WS197=n where n is the index (1-4) of the NEI to register, to select the NEI

6. +WPREG to register on the CDPD network.  The modem will reply as noted in the section
above on manual registration.

7. +WS56? to query the registration status.  Repeat this command until it returns a value of
1 (registered) or until the host chooses to timeout, failing the connection.

8. O to start the session.  The modem will reply with CONNECT at which point you are in data
state.

The modem is now ready to pass host packets to the network.  Any incoming packets, from any
originator, will be passed to the host.  This allows the host to send and receive packets to multiple
destinations asynchronously provided the host can manage multiple socket connections.

Detailed Discussion

The first two steps simply place the modem in CDPD SLIP mode.  The modem’s session state is
set in register +WS45 (Packet Service) by step 2.  Setting this value to 3 will place the modem in
SLIP mode.  This can be done before or after registration on the network so auto-registration can
occur before this step.

The registration process can be more closely controlled with steps 3 through 6.  Steps 3 and 4 can
be used in auto-register as well as manual register settings.

To send data over the network in SLIP mode the user must enter a data state connection to the
network.  There is no explicit destination in SLIP mode so the Dial command is not supported.
You are better advised to verify the modem has registered and simply go on-line.  Registration is
verified with a response of 1 to the query of register +WS56.

If there are problems with registration, the host should manage a timeout on this process.
Continue to repeat the +WS56? query until you get a response of 1 (registered) or the host timer
expires.

The O command will switch the modem to data state regardless of the registration condition.  This
should only be used if you know the modem has successfully registered on the CDPD network.

Once in data state, the modem acts as a pipe through which data passes.  All PAD and IP protocol
stacks as well as SLIP framing must be implemented on the host (DTE) system.  Windows Dial-up
Networking can provide these services.

Transmitting

Data packets received from the host (DTE) are forwarded to the network in 128 byte segments.
They can be buffered on the modem up to 14 segments (1792 bytes).  Beyond this, there is local
hardware flow control (RTS/CTS) with the host to prevent overflow.

Receiving

Incoming data from the network is buffered (up to 14 x 128 bytes) and is passed to the host as it
arrives.  If the modem has been placed in command state but is still in on-line condition, incoming
data will be buffered.  There is an automatic remote flow control between the modem and the
network to prevent overflow.

Escaping Data State

To escape data state in SLIP mode, the host can issue the escape sequence <0xC0>+++<0xC0>
to the modem.  The hexadecimal value 0xC0 is the SLIP frame character.  This means the modem
will be sent a frame containing nothing but the escape code (+++).  This is parsed by the modem
as an escape and it will not forward the packet to the network.
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The modem will enter command state but remain registered and in on-line condition (the session is
kept open).  If data arrives at the modem while the session is open and the modem is in command
state, the data is buffered as described above.

An alternative to the escape sequence is to pre-set the DTR Options (&D) to either 1 or 2 and then
switch DTR off to escape data state.  If the option is set to 1 (&D1), the modem will enter
command state the same as if the escape sequence was issued; it will remain registered with the
current session still open.  If the DTR Option is 2 (&D2) then the modem will close the session,
de-register, and return to command state.  Note that if auto-registration is enabled, the modem will
switch off DCD (closing the current session) but will remain registered.

If the session has been kept open, the host can re-enter data state by issuing the On-line command
(O).  The modem will respond with CONNECT and data state is restored.

5.7.1.2. Closing a SLIP Session

To end a SLIP session, escape data state as described above.  If the &D2 DTR option is used then
the session is closed.

If the escape sequence or the &D1 DTR option is used then you must hang-up with either H0 or
H1 to close the session.  Both of these will close the current session.  If the modem is set to
manual registration, it will also be de-registered by both of these commands.

H1 will force de-registration of the modem even if auto-registration is enabled.  The modem will
remain de-registered.  Although auto-registration remains enabled, the modem will not resume
auto-registration until the register is reset (+WS173=1) or the modem itself re-enters CDPD mode
(a modem reset or power cycle on CDPD-only modems).

5.7.2. User Datagram Protocol (UDP)

UDP is the most basic transport protocol provided by the modem.  It is a thin protocol, adding
only a port specification to the underlying Internet Protocol (IP).  It has the same features as IP,
that is a best effort, connectionless delivery service, with the chief benefit being minimum
overhead.

UDP is not considered reliable because packet delivery is not guaranteed.  Packets can be lost,
duplicated, delayed, or delivered out of sequence.  These conditions are not detected, and the
sender or receiver is not informed.

UDP is connectionless because sender and receiver are never logically connected.  If the intended
receiver is not active and available the message is lost.  It is a best effort delivery, because the IP
software makes an earnest attempt to deliver the packets, failing only if system resources are
overloaded or the underlying networks fail.

Application programs using UDP must accept full responsibility for handling the problems of
reliability, including message loss, duplication, delay, out-of-order delivery, and loss of
connectivity.

These problems are often treated casually by programmers.  Testing done when using highly
reliable, low delay local networks may not expose potential failures.  This explains why many
applications that use UDP work well in a local environment but often fail in dramatic ways on a
more global network.

5.7.2.1. Opening a UDP Client Session

Client sessions are those in which your modem initiates a conversation with a server.

A detailed discussion of this type of session follows the outline of steps to open a UDP Client
Session. (AT is omitted for brevity):

1. +WS46=4 to place the modem in CDPD mode (only required on the SB320).

2. +WS45=0 to select UDP packet service.
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3. Optionally assign a channel with +WPCHAN=n where n is the channel to use.

4. Optionally verify the channel acquisition with +WPRSSI looking for the second value in the
return string to be 3.

If the modem is using auto-registration (+WS173=1) skip to step 7.

5. +WS197=n where n is the index (1-4) of the NEI to register, to select the NEI

6. +WPREG to register on the CDPD network.  The modem will reply as noted in the section
above on manual registration.

7. +WS56? to query the registration status.  Repeat this command until it returns a value of
1 (registered) or until the host chooses to timeout, failing the connection.

8. +WS212=<port> where <port> is the port number (1025-4999) that the modem will be
calling on and listening to.  The modem will only accept packets addressed to this port.  The
factory default is 2100.

9. D<dest> where <dest> is the destination IP and port number to send your data to.  See the
AT Command Reference for details on this command.  The modem will reply with
CONNECT at which point you are in data state.

The modem is now ready to accept host data for packet assembly and transmission to the network.

Any incoming packets, from an originator other than the <dest> will be ignored.  Incoming
packets from the <dest> address will be passed to the host.  This allows the host to exchange data
with a specific station.

Detailed Discussion

The first two steps simply place the modem in CDPD UDP mode.  The modem’s packet service is
set in register +WS45 (Packet Service) by step 2.  Setting this value to 0 will enable the modem’s
UDP stack.  This can be done before or after registration on the network so auto-registration can
occur before this step.

The registration process can be more closely controlled with steps 3 through 6.  Steps 3 and 4 can
be used in auto-register as well as manual register settings.

To send data over the network in a UDP client session the user must enter a data state connection
to the network with a specific IP address and port number.  The On-line command (O) can be used
with the modem using the default IP address and port.  Unfortunately, there is no way for you to
verify what this destination is, so we recommend you issue the dial command with an explicit
destination each time you start a client session.

The listening port (+WS212) must be set to the desired port number to communicate over.  Both
the client and server must share this port number.

The IP of the destination can be any valid IP.  Client sessions do not apply the Friends Only
restrictions.  If the Dial command is given bad syntax including an invalid destination IP or port
number, then it will return the ERROR result code.

The Dial command can handle the network registration process using the NEI indexed by the auto-
register index or the one specified with the N=v dial modifier.  See the AT Command Reference
for details.  This means steps 3 through 6 can be omitted if desired.

The response to the Dial command will depend on the setting of register +WS179 (Registration
Wait Status).  If the setting is 0 (the default) then the CONNECT code is returned regardless of the
success or failure of the modem to register.  If the modem was not registered then the dial
command must perform the task.  The UPD PAD is ready and you may start assembling data into
a packet while the registration process proceeds in parallel.  The modem will buffer the data until
the modem registers.  A failure to register is NOT reported to the host, and the packet can be lost.
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If the Registration Wait Status register is set to 1, then the modem will not respond to the dial
command until the registration process terminates.  In this case, the response can be one of the
following:

CONNECT The modem must have successfully registered and you can
communicate with the network.

NO CARRIER The modem failed to register with the network within the time allowed
by +WS198.

ERROR An invalid IP or port number was specified or there was some other
error in the Dial command syntax.

It is important to understand that CONNECT does not mean that you have established a
communication link with the destination.  UDP is “connectionless”, meaning that you only have a
connection to the network.  Data packets are not guaranteed to reach their destination using UDP.

Transmitting

Once in data state, the modem uses its PAD management services to assemble the data coming
from the host into packets.  See Section 5.8 for a discussion of these services.

Receiving

When the connection is established actively (by a D (Dial) or O (On-line) command), the modem
treats the connection as a client session.  Incoming packets are accepted from the destination
address specified in the Dial command (or defaulted in the On-line command) regardless of
whether or not it is contained in the Friends list.

Any packets arriving from an IP other than that in the Dial command are ignored.

If the modem has been placed in command state but is still in on-line condition, incoming data
will be buffered.  There is an automatic remote flow control between the modem and the network
to prevent overflow.

5.7.2.2. Escaping Data State

There are two methods to escape data state in UDP packet service.  The host can issue the PAD
Time Independent Escape Sequence (TIES) if it is enabled, or the DTR Option can be used if it is
enabled.

TIES

This method is enabled with register +WS60=1 (the default).  It is disabled with a setting of 0
(zero).

When enabled, the host can send AT+++ as a packet.  The “AT” portion must be in uppercase.
See Section 5.8 for details on packet management and notes regarding the PAD Inter-Character
Timer.

When the TIES is received by the modem, it will enter command state but remain registered and in
on-line condition (the session is kept open).  If data arrives at the modem while the session is open
and the modem is in command state, the data is buffered as described above.  See below for
instructions on closing the session.

If the session has been kept open, the host can re-enter data state by issuing the On-line command
(O).  The modem will respond with CONNECT and data state is restored.

DTR Option

An alternative to TIES is to pre-set the DTR Options (&D) to either 1 or 2 and then switch DTR
off to escape data state.  If the option is set to 1 (&D1), the modem will enter command state and
remain registered with the current session still open.  If the DTR Option is 2 (&D2) then the
modem will close the session, de-register, and return to command state.  Note that if auto-
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registration is enabled, the modem will switch off DCD (closing the current session) but will
remain registered.

If the session has been kept open, the host can re-enter data state by issuing the On-line command
(O).  The modem will respond with CONNECT and data state is restored.

5.7.2.3. Closing a UDP Session

To end a UDP session, escape data state as described above.  If the &D2 DTR option is used then
the session is closed.

If TIES or the &D1 DTR option is used then you must hang-up with either ATH0 or ATH1 to
close the session.  Both of options of the Hook Control (H) command will close the current
session.  If the modem is set to manual registration, it will also be de-registered by both of these
options.

ATH1 will force de-registration of the modem even if auto-registration is enabled.  The modem
will remain de-registered.  Although auto-registration remains enabled, the modem will not
resume auto-registration until the register is reset (+WS173=1) or the modem itself re-enters
CDPD mode (a modem reset or power cycle on CDPD-only modems).

NOTE:  There is a PAD Inactivity Timeout in register S30 that can also close a session.  This
timer is disabled by default (set to 0) but can be set to a value from 1 to 20 minutes to prevent the
modem from holding an idle session open.  If this mechanism closes the session the modem will
send the message “OK” to the host and return to command state.  The Carrier Detect (DCD) signal
will also go inactive indicating the session is closed.

5.7.2.4. Opening a UDP Server Session

Server sessions are those in which your modem answers a “call” from another system.

A detailed discussion of this type of session follows the outline of steps to open a UDP Server
Session. (AT is omitted for brevity):

1. +WS46=4 to place the modem in CDPD mode (only required on the SB320).

2. +WS45=0 to select UDP packet service.

3. Optionally assign a channel with +WPCHAN=n where n is the channel to use.

4. Optionally verify the channel acquisition with +WPRSSI looking for the second value in the
return string to be 3.

If the modem is using auto-registration (+WS173=1) skip to step 7.

5. +WS197=n where n is the index (1-4) of the NEI to register, to select the NEI

6. +WPREG to register on the CDPD network.  The modem will reply as noted in the section
above on manual registration.

7. +WS56? to query the registration status.  Repeat this command until it returns a value of
1 (registered) or until the host chooses to timeout, failing the connection.

8. +WS212=<port> where <port> is the port number (1025-4999) that the modem will listen
to.  The modem will only accept packets addressed to this port.  The factory default is 2100.

9. S0=1 sets the modem into auto-answer mode.  The modem will remain in command state
until a message is received from the network.

The session is not actually opened until the first acceptable packet is received.

In server sessions the modem will check all incoming packets for the source IP address.  If Friends
Only is enabled, the originator’s IP address is checked against entries in the Friends List.  If no
match is found the packet is discarded.  If there is a match, or the Friends List is empty, the
modem will also verify that the destination port is matched to the listening port set in register
+WS212.  If so, the session is opened (if necessary) and the packet is passed to the host (DTE).
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When a packet does arrive for the host, the modem will first send the messages “RING” and
“CONNECT <ip>” (where <ip> is the address of the calling station) to the host to indicate the
transition from command state into data state.  The CONNECT message provides a “caller ID”.
The incoming packet is then presented to the host and the modem is ready to accept host reply data
for packet assembly and transmission to the network.

Detailed Discussion

The first two steps simply place the modem in CDPD UDP mode.  The modem’s packet service is
set in register +WS45 (Packet Service) by step 2.  Setting this value to 0 will enable the modem’s
UDP stack.  This can be done before or after registration on the network so auto-registration can
occur before this step.

The registration process can be more closely controlled with steps 3 through 6.  Steps 3 and 4 can
be used in auto-register as well as manual register settings.

The listening port (+WS212) must be set to the desired port number to communicate over.  Both
the client and server must share this port number.

In a server session, the host does not originate transmissions, but rather waits for service requests
from a calling client.  The modem does not enter data state until the first packet is received.

Receiving

Incoming packets are accepted from the network only if the IP of the sender is on the Friends List
or the list is empty (Friends Only disabled) and the destination port matches the listening port set
in register +WS212.  Any packets arriving from an IP other than those accepted are ignored.

When a packet arrives, the IP address and port of the sender is stored as the address to send
packets to.  See Transmitting for additional details and issues on this.

If the modem has been placed in command state but is still in on-line condition, incoming data
will be buffered.  There is an automatic remote flow control between the modem and the network
to prevent overflow.

Transmitting

Once in data state, the modem uses its PAD management services to assemble the data coming
from the host into packets.  See Section 5.8 for a discussion of these services.

NOTE – Reply Addressing in UDP Server Sessions

The source address (IP address and port number) of the last accepted packet is saved
in a temporary variable for use as the current destination address for all packets being
sent by the modem during the current server session.

This can lead to some conflict on busy systems.  If a packet arrives from source A and
is currently being serviced by the host when a packet arrives from source B, a reply
intended for A will be sent to B.

A future firmware revision will implement a BUSY response which will avoid this
problem.  For now, this situation cannot be avoided in UDP server sessions.  The only
remedy is to use the TCP PAD to establish distinct point-to-point communication links.

The host will only know the identity of the calling station from the “caller ID” provided in the
CONNECT message.  Once in data state the incoming packets could be from any acceptable
station (based on Friends Only activation) and matching the listening port.

The normal behaviour would have the server receive a message, issue a reply, and then close the
session.  Auto-answer will be re-enabled so the client can send another packet if needed which
will appear to the host as a new session with “caller ID”.

An alternative would have all clients use an agreed protocol in which the client includes station
identification data within the packet.  It is the user’s responsibility to supply this level of protocol.
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5.7.2.5. Escaping Data State

Escaping a UDP server session is handled exactly the same way as a client session.  See
Section 5.7.2.2 above for details.

5.7.2.6. Closing a UDP Server Session

Closing a server session is handled exactly the same way as a client session.  See Section 5.7.2.3
above for details.

Provided the modem is set to auto-register and H1 is not used to close the session, the modem is
ready for the next UDP server session without further configuration.  Auto-answer will remain
enabled and the modem registered on the network.

To disable auto-answer, you must set register S0=0.  This will prevent the modem from starting
any further server sessions.

5.7.2.7. UDP Broadcast and Multicast

These services are not yet supported by the SB300 Series modems but are planned for future
firmware upgrades.

Broadcast and multicast are CDPD functions that support sending the same data to a large group
of IP Addresses with a single transmission to the CDPD network.  This capability is implemented
through Mobile Data Intermediate System (MDIS) software.  Check with your carrier to determine
if these capabilities are offered before planning to use it as part of your application.

Broadcast and multicast transmissions are point-to-multi-point and provide a one-way UDP
connectionless service.  The operational considerations are:
• Protocol restrictions prevent broadcast or multicast messages from being encrypted.
• Broadcast or multicast data packets will not be received by a SB300 Series modem with an

active TCP PAD session.
• If a UDP PAD session is active the broadcast and multicast messages will be interspersed

with the application data packets and must be separated by the application.
• In the case of SLIP, the disposition of the broadcast and multicast messages is a function of

the support provided by the software stack and end-user applications (one must be UDP)
operating on the Mobile Application Subsystem (MAS).  If a UDP session is not active, the
messages will be lost.

Broadcast

The Broadcast function is used on a geographic coverage basis.  To support this function the
MDIS is set up with a Broadcast NEI that includes a list of the Mobile Data Base Stations
(MDBSs) in the desired broadcast area in its definition.  There can be multiple broadcast areas
within the coverage area of a single MDIS.  A message is transmitted to a Broadcast NEI at the
MDIS that replicates the message, puts a special broadcast header on it, and sends it to the cells
indicated by the broadcast list.

For most applications broadcast is not appropriate, because broadcast messages are sent to all the
CDPD modems in the covered geography.  It is more useful to be able to specify that messages
only go to all, or a subset of the IP Addresses associated with a specific customer; a capability
offered by multicast.

Multicast

Multicast is set up similarly to broadcast, except that the MDIS is set up with a Multicast NEI and
a list of the terminals that belong to that specific group rather than a list of cells, as used by the
broadcast function.  The message to be multicast is sent to the Multicast NEI at the MDIS, which
replicates the message and sends individual messages to the terminals indicated in its multicast
group list.

A terminal can be a member of any number of multicast groups, however it can only be active in
one at any given time.  A terminal wishing to receive multicast messages indicates its readiness by
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registering a Multicast NEI and by being ready to receive UDP datagrams.  The latter can be
accomplished by having the UDP Server function set to active, or if in SLIP mode, by having a
UDP application set to ready.  In all of the preceding cases the MAS is assumed to be ready to
process any incoming multicast datagrams.

Contact the service provider for information on the availability and use of multicast service in
your area.

5.7.3. Transmission Control Protocol (TCP)

Transmission Control Protocol (TCP) is an advanced transmission protocol that adds substantial
functionality to the underlying Internet Protocol it is built on.  Because of this structure it is often
referred to as TCP/IP.  The advantage of TCP is reliability of data transmission; achieved by using
positive acknowledgements with retransmission if required.  The main disadvantage is the
overhead needed to provide this reliability under various conditions.

Due to the positive acknowledgements used in TCP, it is not recommended that sleep modes be
enabled in the modem.  If the modem goes to sleep, the possible delays in sending and picking up
acknowledgements can result in excessive re-transmissions and even lost connections.

Unlike UDP, TCP offers both reliable and connected data transmission service.  Lost, delayed,
duplicated, or out of sequence packets are detected and automatically corrected.  A logical point-
to-point connection is established and maintained throughout the communications session.  It
requires very little other than session establishment, sending data over the serial port, and session
termination to get a basic application operational.

The price for this reliability is the number of extra data packets used and the time required to
process them.  Both need to be considered when selecting an application protocol.

5.7.3.1. Configuring a TCP Client Session

Client sessions are those in which your modem initiates a conversation with a server.

A detailed discussion of this type of session follows the outline of steps to open a TCP Client
Session. (AT is omitted for brevity):

1. +WS46=4 to place the modem in CDPD mode (only required on the SB320).

2. +S31=0 to disable logic sleep.

3. +WS175=0 to disable CDPD sleep.

4. +WS45=1 to select TCP packet service.

5. Optionally assign a channel with +WPCHAN=n where n is the channel to use.

6. Optionally verify the channel acquisition with +WPRSSI looking for the second value in the
return string to be 3.

If the modem is using auto-registration (+WS173=1) skip to step 9.

7. +WS197=n where n is the index (1-4) of the NEI to register, to select the NEI

8. +WPREG to register on the CDPD network.  The modem will reply as noted in the section
above on manual registration.

9. +WS56? to query the registration status.  Repeat this command until it returns a value of
1 (registered) or until the host chooses to timeout, failing the connection.

10. +WS212=<port> where <port> is the port number (1025-4999) that the modem will be
calling on and listening to.  The modem will only accept packets addressed to this port.  The
factory default is 2100.
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11. D<dest> where <dest> is the destination IP and port number to send your data to.  See the
AT Command Reference for details on this command.  The modem will reply with
CONNECT at which point you are in data state.

The modem is now ready to accept host data for packet assembly and transmission to the network.

Any incoming packets, from an originator other than the <dest> will be ignored.  Incoming
packets from the <dest> address will be passed to the host.  This allows the host to exchange data
in a point-to-point connection on a specified port with a specific station.

Detailed Discussion

The first four steps simply place the modem in CDPD TCP mode.  The modem’s sleep features
are disabled to prevent delays in TCP acknowledgements, which would cause excessive re-
transmissions and possibly loss of connection.  The modem’s packet service is set in register
+WS45 (Packet Service) by step 4.  Setting this value to 1 will enable the modem’s TCP stack.
This can be done before or after registration on the network so auto-registration can occur before
this step.

The registration process can be more closely controlled with steps 5 through 8.  Steps 5 and 6 can
be used in auto-register as well as manual register settings.

To send data over the network in a TCP client session the user must enter a data state connection
to the network with a specific IP address and port number.

The On-line command (O) can only be used after a session has started.  The Dial command must
be used to establish the TCP point-to-point connection.  Once established, the host can escape data
state and then use this command to return to data state with the point-to-point connection still
intact.

The listening port (+WS212) must be set to the desired port number to communicate over.  Both
the client and server must share this port number.

The IP of the destination can be any valid IP.  Client sessions do not apply the Friends Only
restrictions.  If the Dial command is given bad syntax including an invalid destination IP or port
number, then it will return the ERROR result code.

The Dial command can handle the network registration process using the NEI indexed by the auto-
register index or the one specified with the N=v dial modifier.  See the AT Command Reference
for details.  This means steps 3 through 6 can be omitted if desired.

Note that two timers are used for the connection process.  +WS198 (Registration Wait Time) is
used to timeout the network registration process.  The default is 30 seconds.  A second timer at S7
(TCP PAD Timeout) is used to time the TCP connection handshake.  This timer defaults to 30
seconds as well.  The TCP PAD Timeout starts when the Dial command is issued.  If modem was
not already registered, then network registration will consume time from this timer as well.  In
other words, the TCP PAD Timeout can run concurrently with the Registration Wait Timer.

The response to the Dial command when TCP is enabled does not depend on the setting of register
+WS179 (Registration Wait Status).  The CONNECT code is only returned on the successful
network registration and TCP negotiation with the destination.  A failure to register or negotiate
TCP is reported to the host by either a NO CARRIER or NO ANSWER result code.  The response
can be one of the following:

CONNECT The modem has successfully registered and established the TCP
connection.  You can now communicate with your destination.

NO CARRIER The modem failed to register with the network within the time allowed
by +WS198.

NO ANSWER The modem could register with the network but could not negotiate the
TCP handshake with your destination within the time allowed by
register S7.

ERROR An invalid IP or port number was specified or there was some other
error in the Dial command syntax.
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PAD ERROR An internal modem error has occurred in the TCP stack.  The modem
will have to be reset.

Unlike UDP, a CONNECT message in TCP service does mean that you have established a
communication link with the destination.

Transmitting

Once in data state, the modem uses its PAD management services to assemble the data coming
from the host into packets.  See Section 5.8 for a discussion of these services.

Receiving

Incoming packets are accepted from the destination address specified in the Dial command
regardless of whether or not it is contained in the Friends list.

Any packets arriving from an IP other than that in the Dial command are ignored.

If the modem has been placed in command state but is still in on-line condition, incoming data
will be buffered.  There is an automatic remote flow control between the modem and the network
to prevent overflow.

5.7.3.2. Escaping Data State

There are two methods to escape data state in TCP packet service.  The host can issue the PAD
Time Independent Escape Sequence (TIES) if it is enabled, or the DTR Option can be used if it is
enabled.

TIES

This method is enabled with register +WS60=1 (the default).  It is disabled with a setting of 0
(zero).

When enabled, the host can send AT+++ as a packet.  The “AT” portion must be in uppercase.
See Section 5.8 for details on packet management and notes regarding the PAD Inter-Character
Timer.

When the TIES is received by the modem, it will enter command state but remain registered and in
on-line condition (the session is kept open).  If data arrives at the modem while the session is open
and the modem is in command state, the data is buffered as described above.  See below for
instructions on closing the session.

If the session has been kept open, the host can re-enter data state by issuing the On-line command
(O).  The modem will respond with CONNECT and data state is restored.

DTR Option

An alternative to TIES is to pre-set the DTR Options (&D) to either 1 or 2 and then switch DTR
off to escape data state.  If the option is set to 1 (&D1), the modem will enter command state and
remain registered with the current session still open.  If the DTR Option is 2 (&D2) then the
modem will close the session, de-register, and return to command state.  Note that if auto-
registration is enabled, the modem will switch off DCD (closing the current session) but will
remain registered.

If the session has been kept open, the host can re-enter data state by issuing the On-line command
(O).  The modem will respond with CONNECT and data state is restored.

5.7.3.3. Closing a TCP Session

To end a TCP session, escape data state as described above.  If the &D2 DTR option is used then
the session is closed.

If TIES or the &D1 DTR option is used then you must hang-up with either ATH0 or ATH1 to
close the session.  Both of these command options will close the current session.  If the modem is
set to manual registration, it will also be de-registered by both of these options.
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ATH1 will force de-registration of the modem even if auto-registration is enabled.  The modem
will remain de-registered.  Although auto-registration remains enabled, the modem will not
resume auto-registration until the register is reset (+WS173=1) or the modem itself re-enters
CDPD mode (a modem reset or power cycle on CDPD-only modems).

NOTE:  There is a PAD Inactivity Timeout in register S30 that can also close a session.  This
timer is disabled by default (set to 0) but can be set to a value from 1 to 20 minutes to prevent the
modem from holding an idle session open.  If this mechanism closes the session the modem will
send the message “NO CARRIER” and return to command state.  The Carrier Detect (DCD)
signal will also go inactive indicating the session is closed.

5.7.3.4. Opening a TCP Server Session

Server sessions are those in which your modem answers a “call” from another system.

A detailed discussion of this type of session follows the outline of steps to open a TCP Server
Session. (AT is omitted for brevity):

1. +WS46=4 to place the modem in CDPD mode (only required on the SB320).

2. +S31=0 to disable logic sleep.

3. +WS175=0 to disable CDPD sleep.

4. +WS45=1 to select TCP packet service.

5. Optionally assign a channel with +WPCHAN=n where n is the channel to use.

6. Optionally verify the channel acquisition with +WPRSSI looking for the second value in the
return string to be 3.

If the modem is using auto-registration (+WS173=1) skip to step 9.

7. +WS197=n where n is the index (1-4) of the NEI to register, to select the NEI

8. +WPREG to register on the CDPD network.  The modem will reply as noted in the section
above on manual registration.

9. +WS56? to query the registration status.  Repeat this command until it returns a value of
1 (registered) or until the host chooses to timeout, failing the connection.

10. +WS212=<port> where <port> is the port number (1025-4999) that the modem will listen
to.  The modem will only accept packets addressed to this port.  The factory default is 2100.

11. S0=1 sets the modem into auto-answer mode.  The modem will remain in command state
until a TCP handshake is completed with a calling client.

The session is not actually opened until a TCP connection handshake is negotiated with an
accepted IP address on the listening port.  In server sessions the modem will check all incoming
packets for the source IP address.  If Friends Only is enabled, the originator’s IP address is
checked against entries in the Friends List.  If no match is found the handshake will fail and the
host will not be advised of any activity.  This is handled entirely within the modem.

If the originator’s IP is accepted the session is opened and the host is notified with the messages
“RING” and “CONNECT <ip>” (where <ip> is the address of the client station).  The
CONNECT message provides a “caller ID”.  At this point the modem changes from command
state to data state.  Incoming packets are then presented to the host and the modem is ready to
accept host reply data for packet assembly and transmission to the client.

Detailed Discussion

The first four steps simply place the modem in CDPD TCP mode.  The modem’s sleep features
are disabled to prevent delays in TCP acknowledgements, which would cause excessive re-
transmissions and possibly loss of connection.  The modem’s packet service is set in register
+WS45 (Packet Service) by step 4.  Setting this value to 1 will enable the modem’s TCP stack.
This can be done before or after registration on the network so auto-registration can occur before
this step.
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The registration process can be more closely controlled with steps 5 through 8.  Steps 5 and 6 can
be used in auto-register as well as manual register settings.

The network registration is verified by testing register +WS56.  Once registered the modem is
configured to receive calls.

The listening port (+WS212) must be set to the desired port number to communicate over.  Both
the client and server must share this port number.

In a server session, the host does not originate transmissions, but rather waits for service requests
from a calling client.  The modem does not enter data state until a successful TCP handshake has
been negotiated.

Receiving

Incoming requests for TCP connection are accepted from the network only if the IP of the sender
is on the Friends List or the list is empty (Friends Only disabled) and the destination port matches
the listening port.  Any connection requests or packets arriving from an IP other than those
accepted are ignored.

Once the session has been started, the modem will only receive packets from the connected client
IP.  This will remain in effect until the session is closed.

If the modem has been placed in command state but is still in on-line condition, incoming data
will be buffered.  There is an automatic remote flow control between the modem and the network
to prevent overflow.

Transmitting

Once in data state, the modem uses its PAD management services to assemble the data coming
from the host into packets.  See Section 5.8 for a discussion of these services.

All outgoing packets are directed to the connected client IP until the connection is closed.

5.7.3.5. Escaping Data State

Escaping data state to allow the issuing of AT commands to the modem is handled exactly the
same way as a client session.  See Section 5.7.3.2 above for details.

5.7.3.6. Closing a TCP Server Session

Closing a server session can be handled in three ways.
• The server host can close the session exactly the same way as a client session.  See

Section 5.7.3.3 above for details.
• The client can disconnect.  The server host will receive the “NO CARRIER” message and the

Carrier Detect (DCD) signal will go inactive indicating the session has closed.
• The modem can close the session if the PAD Inactivity Timeout in register S30 expires.  This

timer is disabled by default (set to 0) but can be set to a value from 1 to 20 minutes to prevent
the modem from holding an idle session open.  If this mechanism closes the session the
modem will send the message “NO CARRIER” and return to command state.  The Carrier
Detect (DCD) signal will also go inactive indicating the session is closed.

Provided the modem is set to auto-register and ATH1 is not used to close the session, the modem
is ready for the next server session without further configuration.  Auto-answer will remain
enabled and the modem registered on the network.

To disable auto-answer, you must set register S0=0.  This will prevent the modem from opening
any further server sessions.
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5.8. Packet Assembly Management

Once in data state with either the UDP or TCP PAD enabled, the modem accepts data from the
host (DTE) and assembles it into packets.  Packet assembly is largely transparent to the host but
some assembly management features are available.

Starting a Packet

A packet is started when the host starts sending data to the modem.  The modem will buffer the
data as it assembles the packet.

Real Time Data Entry and Editing

The modem can echo characters from the host back to it is cases where a terminal application is
being used to allow individuals to type and send messages in real time.  This is similar to Internet
Relay Chat (IRC).  Setting +WS62=1 will enable the echo (the default) and setting +WS62=0
will disable it.

If this type of communication is being used, the modem can also optionally allow editing of the
packet buffer.  Setting +WS72=1 (the default) will enable local editing of the data before it is
forwarded to the network.  This allows you to backspace using the character set in +WS73 (the
default is 8 <BS>).  If local echo is also enabled then the modem will echo the backspace
character, a space, and another backspace.

Forwarding a Packet

The modem closes and sends a packet when one of the following events occur:

1. The maximum packet length set in +WS74 (default 1000) is reached.  You may wish to set
this value smaller if you are encountering too many packet errors and retransmissions.  Setting
it below 5 will preclude use of the TIES to exit data mode.  See below for details.

2. The modem receives the PAD Primary Forwarding Character set in register +WS64.  This
character defaults to 13, the carriage return <CR>.  The feature is enabled by default and can
be controlled with a bit mask option set in register +WS63.  The options are:
0 Disabled
1 The packet is terminated and the forwarding character is discarded.
3 The forwarding character is included in the packet before the packet is closed and sent.
The default option setting is 3.

3. The PAD Inter-Character Timer (+WS70) expires.  This timer is disabled (set to 0) by
default.  It can be set to values from 0.1 to 25.5 seconds.  If particularly short times are used,
real time typing will be forwarded virtually as it is received.  This would also mean that
manually typing the TIES to escape data mode is virtually impossible as the packet is closed
before the full character string is entered.

NOTE:  If you disable the primary forwarding character (+WS63=0) and the timer (+WS70=0),
the only way to forward packets will be to fill the packet buffer.  This is very strongly
discouraged.

Using TIES

The Time Independent Escape Sequence (TIES) is a method to shift the modem from data state to
command state.  It is enabled by setting +WS60=1 (the default) and disabled by setting
+WS60=0.

The escape sequence is a packet containing only the string “AT+++” where the “AT” must be in
uppercase.  To ensure the packet contains only this value you must be sure that you are starting a
new packet and that the modem will not close the packet before the string is complete.

To ensure you are starting a packet, you must ensure that one of the forwarding events described
above has occurred.  The easiest way is to send the Primary Forwarding Character.

To ensure that you can enter the complete string, you cannot set the maximum packet length less
than 5.  You must also provide sufficient time in the PAD Inter-Character Timer to enter each
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character.  If this is to be manually typed, the value should be set quite high (or disabled
altogether).  You must also avoid setting the PAD Primary Forwarding Character (+WS64) to one
of the three characters in the TIES string (A=65 ,T=84 ,+=43 ).

5.9. Data and Telemetry Applications

If you are communicating data files or telemetry using one of the modem’s PAD services (UDP or
TCP) that do not involve direct human interaction, you should make appropriate changes to the
packet management features of the modem.

Exact settings will depend on the nature of your application and the quality of your network
connection.  What follows are some issues to consider.

If binary data is being communicated, you should disable the PAD Primary Forwarding Character
feature (+WS63=0) and use the PAD Inter-Character Timer (+WS70=5) instead.  This will
prevent unusually small packets where the forwarding character might occur frequently in the
binary data.  It will also ensure data is forwarded to the network within a roughly known period.
This allows the server to detect if problems have occurred at the client end.

The maximum packet length (+WS74) should be set as best suits the size of the data or telemetry
files you are sending.  Remember that, in areas of poor network connectivity where
retransmissions are frequent, overall throughput may be improved by using smaller packet sizes.

Specific modem configuration samples for particular case studies may be available soon from the
Sierra Wireless Internet site at www.sierrawireless.com.
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6. CSC Operation

This section provides information on configuring and using the SB320 modem in Circuit Switched
Cellular (CSC) mode if you are not using Watcher and Windows Dial-up Networking for your
connections.  If you are using a standard Windows-based application then consult Section 3.3
Configuration using WirelessExpert.

The introduction provides some background on CSC communications in general.

6.1. Introduction

Circuit Switched Cellular is a wireless mode of communication in which the data link connection
between the SB320 modem and the remote modem is made over the circuit switched voice cellular
network.  This voice cellular network is based on the Advanced Mobile Phone Service (AMPS).

Data communications are carried on over this link as if a standard landline telephone connection is
being used.  Circuit Switched Cellular is perhaps the most familiar form of wireless data and voice
communications.  This mode works like normal wireline communication except that the modem
link is over a cellular phone call rather than a landline phone call.  Like cellular phones, cellular
modems have their own telephone number and require a dedicated channel for the duration of the
call.

6.1.1. Modem Registration

6.1.1.1. Cellular Phone Number

Using the modem over the cellular network requires that the modem be assigned a Number
Assignment Module (NAM).  This is essentially the phone number associated with your modem.
This is assigned to you when you register your modem with a cellular carrier.  The cellular carrier
requires the unique Electronic Serial Number (ESN) which is assigned to your modem at the
factory.

The unit is capable of retaining two NAMs, with each NAM being independently assigned to any
cellular service provider.

As with your credit card number, bank machine number, or any other private password, you
should safeguard the NAM and keep it private.

Calls made with the Sierra Wireless modem using CSC mode are not possible until the NAM has
been programmed.  The NAM data consists of the cellular phone number as well as other
subscriber and cellular service provider information.

6.1.1.2. Electronic Serial Number (ESN)

The Sierra Wireless modem stores the ESN internally.  You can display it through the Watcher
application by choosing Help > About from the main menu when the modem is operating in
Circuit Switched Cellular mode.  You can also display the ESN by using the AT+WVESN
command.  The ESN is displayed in text form for both NAMs.

6.1.2. CSC Radio Coverage

Because the cellular radio channel is an inherently noisy channel (unlike the public switched
telephone network), the remote modem to which the Sierra Wireless modem places a call should
as a minimum, support the V.42 error correction standard.  This will correct the errors in data
transmission that occur over the radio channel.
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These errors result from various forms of electrical interference, noise generated by other cellular
subscribers (especially during peak usage periods), and the user being located in areas of poor
cellular coverage such as remote locations or inside buildings.  The use of any cellular device
inside a building suffers from varying degrees of signal loss due to losses in the building walls and
office materials inside the building. Better signals can be achieved by locating the modem near a
window or other opening and by ensuring that the modem antenna is deployed in the vertical
position.

Within any cellular network, there will be regions of poor signal coverage.  In these areas, noise
will affect communications.  In addition, an effect known as co-channel interference can be heard
on the cellular channel.  This is interference from a cellular phone in a different cell.  These effects
will sporadically limit the communications link, leading to momentary loss of data, or a dropped
call.

6.1.3. Modem Pools

As discussed in Section 4.5.2 above, there are significant performance differences between
configuration profiles for cellular modems and landline modems.  To help alleviate this, some
cellular carriers offer modem pools for cellular data calls.

Modem pools were developed to overcome the need to have a “cellularly aware” modem at the
landline side of a cellular data link.  The end to end link actually consists of two back to back
modem connections.  The cellular modem initiates a connection with the cell-side modem in a
pool, while at the same time the land-side modem in the pool initiates a connection with the
destination landline modem.  The two modems within the modem pool pass data between
themselves using a buffered digital link.  The cell-side modem typically supports the necessary
features to ensure a robust modem link.

To use a modem pool for a call, involves prefixing the called phone number with *DATA
(*3282).

Although benefits are generally gained by using modem pools, there are a few disadvantages to
this configuration:
• Call initiation time is long, and there can be long delays in end to end character echo.
• Calls to mobile modems cannot be made through a modem pool.
• Configuration is unique from base-station to base-station, it is not always optimized.

Section 6.5 below provides information for advanced users on optimizing the modem for
particular environments.

6.2. Configuring the Modem for CSC

You can configure the settings using either WirelessExpert or Watcher as described in Section 3.3
and 3.5.2.  Alternatively you can enter the configuration using AT commands as described in the
following sub-sections.

6.2.1. Setting the NAM

See Section 2.2.2 for information on registering for CSC cellular service.  Make sure your carrier
gives you a 10-digit NAM (area code plus phone number), Home System ID, and a side
preference (A or B).

1. +WS46=7 to ensure the modem is in CSC mode.

2. +WS178=n where n is the entry you wish to edit (1 or 2).  This will make it the active NAM.

3. +WPNAM? to display the current entry and verify that it can be changed.

4. +WPNAM=num,sys,pref where num is the 10 digit phone number with area code and
without brackets, spaces, or dashes (i.e. 6042311100); sys is the Host System ID provided by
your cellular service provider; and pref is the numeric code for the side preference as shown
below:
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0 – A side preferred,
1 – B side preferred,
2 – A side only,
3 – B side only,
4 – Home only.

When you press <enter> the modem will update the entry and respond OK.  If the response is
ERROR then a parameter was out of range or the syntax was incorrect.

5. +WPNAM? to display the new entry and verify it is correct.

The NAM is now set and is active.  If you wish to enter an alternate NAM then repeat the process
from step 2.  The active NAM used by the modem for CSC connections will be the one indexed by
the +WS178 register when you are finished.

6.2.2. Confirm CSC Service

To ensure that your modem can make a cellular call:

1. +WS46=7 to ensure the modem is in CSC mode.

2. +WS178=n where n is the NAM entry you wish to use.  This will make it the active NAM.

3. +WPNAM? to display the current entry and verify that it is the one to be used.

4. +WPRSSI to verify that you have acquired a channel and the NAM will register.  The reply
to this command is in four lines:

Signal strength in dBm (-0 indicates no signal)
Channel state where 1 indicates scanning and 3 indicates an acquired channel
Registration state where 0 indicates your NAM is not registered, and 1 indicates registration
Channel number (0 indicates scanning).

Use A/ to repeat the RSSI query until your modem can find a channel and register the NAM.
If the modem fails to register the NAM on a channel after one minute then your NAM does
not likely have service in the coverage area.

When the RSSI reports the modem has registered the NAM:

5. ATDnum where num is a telephone number that you can call to detect a ring.  This can be a
voice line at or near your workstation.  The modem will dial the number and you should hear
the ring and see a ring indication reply on the host terminal application.

If you dial a destination modem set to auto-answer, the handshake should complete and the
connection result will be reported.  You can terminate the connection normally.

6. If you call a line which does not answer, press any key to have the modem cancel the call and
return to command state or allow the dial command to timeout.

6.3. Originate a CSC Connection

CSC operates just like regular landline modems except the call is placed over a cellular network.

Watcher (Section 0) can be used to setup the modem for CSC operation.  When set, a call can be
placed using any modem application which can issue a dial command to the port.

Alternatively, Windows Dial-up Networking can be configured to establish a connection.  If Dial-
up Networking (or any other communication application) is used to setup the modem, the setup
string should be:

AT &F5

This command will configure the modem to use ETC settings that improve performance for
cellular connections.  See Section 6.5 below for a full discussion of optimized cellular settings.
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You may freely add necessary settings to control the local DTE/DCE interface (echo, verbose,
quiet, etc.) without altering the remote connection settings.

6.4. Auto-answer a Cellular Call

Your application can use the modem just like any landline modem.  The modem setup string
should be:

AT &F5

AT S0=n where n is the ring count on which the modem will answer the line.

This setup will configure the modem to use ETC settings that improve performance for cellular
connections.  See Section 6.5 below for a full discussion of optimized cellular settings.

You may freely add necessary settings to control the local DTE/DCE interface (echo, verbose,
quiet, etc.) without altering the remote connection settings.

6.5. Optimizing Data Performance

The SB320 modem can be configured for excellent cellular performance.  The AT&T Paradyne
Comsphere product line is recommended as the landline side.  Alternatively cellular modem pools,
sometimes supplied by the cellular service provider are normally good for performance, although
they too need to be properly configured by the cellular carrier to optimize the performance.

The SB320 modem supports V.34 protocol allowing it to achieve higher connection speeds, and to
optimize its filter characteristics dynamically to get the best Signal-to-Noise Ratio (SNR) on a
given link.  This makes for a much more robust and faster connection and speeds of 19200 bps are
not uncommon with this modem if the host supports V.34 as well.

To help determine the nature of the connections being established in trials it may be useful to have
the modem report a more extensive reply.  Setting S95=127 will enable the modem to report the
DCE connection speed, protocol, and compression negotiated.

A number of connection scenarios between a SB320 and a variety of host modems are considered
in the following sections in an attempt to present a guideline to improve connectivity.  The host
modems are divided in two categories: those that support ETC and those that don’t.  Of those
modems that don’t support ETC, a further differentiation is made with regard to those that support
LAPM/V.42bis and those that don’t.  Finally, modem pools with *DATA service are considered
as a separate category, even though these modems do implement ETC.

But first the factory settings are described as a reference point.

6.5.1. Factory Default for ETC

The &F5 command will configure the SB320 for optimal performance on most cellular systems.
This AT command is designed to make it easy for the user or application to set up the modem in
ETC mode.  Sending just this one command will cause the modem to reconfigure all its registers,
including those that are not associated with ETC, to factory default and optimized for ETC
operation.

It is equivalent to sending AT&F0 followed by a series of additional AT commands and S-
Register settings which pertain to ETC mode.  This is why it can be thought of as a ‘super’ AT
command.  A brief description and commentary of each of these additional settings is given
below.

\N5 Enables V.42 LAPM error control only.  This is a requirement of ETC.  The
modem will disconnect if the remote end does not support LAPM.

-K0 This is a companion to the above command indicating a preference for LAPM
when using V.42.
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*H2 This sets the Link Negotiation Speed for the initial connection to 4800 bps.  The
policy of “start slow and train up” guarantees that the initial negotiation phase
has more chance of success.  Start-up speeds of 4800 bps and 9600 bps (*H3)
may be used.  In addition if a connection has not been established after 60
seconds, the modems will fall back to 1200 bps.

S7=120 The Wait for Carrier is set to 120 seconds.  The handshaking process with ETC
enabled and cellular generally can take longer than the default 50 seconds.  This
is especially true of modem pools are being used.

S10=100 Lost Carrier Hang-up Delay is set to 10 seconds.  The default is 0.6 seconds but
cellular links can be interrupted during cell changes and due to other “noise” so
the modem will wait longer to determine if the connection is truly lost.

S51=15 This sets the V.34 symbol rate to 2800 symbols per second and the carrier
frequency control to automatic for transmissions.  The default would allow 3429
symbols per second, which is likely to lead to more failures and retransmissions.

S52=15 This does the same as S51 but for the V.34 receive side.

S55=37 V.34 options are set to enable asymmetric bit rates, and non-linear encoding.  It
disables asymmetric rates, constellation expansion and receiver pre-encoding.

S70=20 This extends the maximum number of retransmissions from the default 12 up to
20.

S96=31 ETC Options are set to enable all features for ETC handshaking.  This includes
enabling a fallback to 1200 bps if higher rates cannot be supported.  It also
enables /ETC to be appended to the CONNECT message.

S106=32 The frame size for LAPM is set to the minimum 32.  The default is the maximum
of 128.  Use of a small frame size does reduce direct throughput, but gives a
more robust connection.  This leads to fewer retransmissions and can improve
overall throughput in noisy connections that require frequent retransmissions.

S108=3 Signal Quality is selected to high, meaning that automatic re-training is activated
at the most sensitive setting.  This means that the modem will re-train on slight
changes in line quality.  This is intended to keep the rate as high as practical.

6.5.1.1. Data Rate

Even with optimal configuration, modems will have a tendency to attempt to communicate at a
data rate that is faster than optimal for overall throughput.  For this reason it is recommended that
register S37 (Desired DCE Speed) be used to limit the maximum data communications rate.  This
register can be set as part of the initialization string eg. ATS37=7.

Remember that the factory setting above sets the speed for the initial negotiation at 4800 bps but
the modem can train up to a maximum set in S37.  The default value for S37 is to connect no
faster than the DTE connection speed (currently fixed at 19200 bps).  This will happen only if the
line conditions allow it.  Otherwise, the modem will connect at a lower speed.

If the modem is found to be training up and down too often due to a constantly changing line
quality, it may be better to reduce the upper limit to 7200 bps (s37=8) or 4800 bps (s37=7).  This
will result in a more stable connection and eliminate excessive speed negotiation.  This is feasible
if speed is not critical to the application or if small amounts of data are transferred at any one time.

Alternatively, if retraining is too frequent, the line quality threshold for retraining can be shifted
down using S108.  This should only be tried under controlled trial conditions to determine the best
balance between signal threshold and maximum line speed.  Transmitting a 100k test file gives a
reasonable measure of throughput efficiency.
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Based on field experience using the &F5 settings, the following limits are recommended:
• V.32bis talking to cellularly aware landline modem – 9600 bps (S37=9)
• V.32bis talking to standard wireline modem – 4800 bps (S37=7)
• V.34 talking to cellularly aware modem – 12000 bps (S37=10)
• V.34 talking to standard wireline modem – 9600 bps. (S37=9)

If only a small amount of data is being transferred, it is recommended that a data rate of 4800 bps
(S37=7) is used.  This will give optimal performance and coverage area.  Error Correction should
always be enabled.  Flow control should be used (hardware recommended).

For situations where even 4800 bps does not hold a connection, the last suggestion is to try a data
link at 1200 bps (s37=5).

6.5.2. Connections to ETC Enabled Modems

Enhanced Throughput Cellular (ETC) is a protocol enhancement designed to optimize cellular
data communications.  It is described in Section 4.5.2.1.

This is the best case scenario and it should be possible to achieve speeds of 9600 – 19200 bps if
the host supports V.34 and ETC.  The table below lists some of the steps for troubleshooting bad
connections at both the SB320 end and the Host modem end.  As a rule, when starting the
troubleshooting procedure, both modems should be reset to their respective factory defaults
settings.  If problems still persist, then a more thorough analysis of each modem’s settings needs
to be done as outlined below.

6.5.3. Connections to Non-ETC Compatible Modems

If the remote modem does not support LAPM and V.22bis then you will have to allow the SB320
to use alternative protocols.  The &F0 command is used.  This AT command configures the
modem in CSC data mode but without ETC enabled.

An additional series of AT commands and S-Register settings should also be set to optimize the
modem to operate in a cellular environment without the benefits of the ETC protocol.  This non-
ETC configuration will then allow the modems to negotiate other protocols such as MNP, etc.

The following additional commands should be sent to configure the modem for CSC mode use
with non-ETC compatible modems:

\N3 Enables V.42 LAPM error control but also allows MNP and will even tolerate a
non-error controlled link.  A setting of 2 is also possible if you want to
disconnect if neither LAPM nor MNP error control can be negotiated.

-K0 This is a companion to the above command indicating a preference for LAPM
when using V.42.

*H2 This sets the Link Negotiation Speed for the initial connection to 4800 bps.  The
policy of “start slow and train up” guarantees that the initial negotiation phase
has more chance of success.  Start-up speeds of 4800 bps and 9600 bps (*H3)
may be used.  In addition if a connection has not been established after 60
seconds, the modems will fall back to 1200 bps.

S7=120 The Wait for Carrier should be set higher than the default 50 seconds to allow for
the added time of cellular (and possibly modem pool) connections.  This sets the
wait to 120 seconds.

S10=100 Lost Carrier Hang-up Delay is set to 10 seconds.  The default is 0.6 seconds but
cellular links can be interrupted during cell changes and due to other “noise” so
the modem will wait longer to determine if the connection is truly lost.

S51=15 This sets the V.34 symbol rate to 2800 symbols per second and the carrier
frequency control to automatic for transmissions.  The default would allow 3429
symbols per second, which is likely to lead to more failures and retransmissions.
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S52=15 This does the same as S51 but for the V.34 receive side.

S55=37 V.34 options are set to enable asymmetric bit rates, and non-linear encoding.  It
disables asymmetric rates, constellation expansion and receiver pre-encoding.

S70=20 This extends the maximum number of retransmissions from the default 12 up to
20.  Higher values are possible if needed.

S106=32 The frame size for error correction protocols is set to the minimum 32.  The
default is the maximum of 128.  Use of a small frame size does reduce direct
throughput, but gives a more robust connection.  This leads to fewer
retransmissions and can improve overall throughput in noisy connections that
require frequent retransmissions.

S108=3 Signal Quality is selected to high, meaning that automatic re-training is activated
at the most sensitive setting.  This means that the modem will re-train on slight
changes in line quality.  This is intended to keep the rate as high as practical.

The data rate discussion in Section 6.5.1.1 also applies to this type of connection.

6.5.4. Connections to Modem Pools

This scenario is also a best case scenario and it should again be possible to achieve speeds of
19200 – 9600 bps in most circumstances.  Modem pools are discussed in Section 6.1.3 above.

The SB320 connection is a cellular one and therefore its pool counterpart will be an ETC-capable
modem.  This means that the SB320 should be configured in its factory default ETC mode using
AT&F5 as described earlier.

The destination modem’s connection to the pool is a standard landline connection and the remote
modem must be configured as such.  In this case the destination modem should be configured to
support the full array of protocols to give it the best possible options for connecting to the cellular
carrier’s modem pool on the landline side.

If any configuration adjustments are to be made, understand that you are either optimizing the
connection from the SB320 to the pool modem or from the destination modem to the pool and not
directly between the SB320 and the destination.
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7. Wireline Operation

7.1. Introduction

Wireline mode is that most commonly associated with computer communications: the modem is
connected via a telephone line.  Only the SB320 supports this mode.

This section provides information on configuring and using the SB320 modem in Wireline mode
if you are not using Watcher and Windows Dial-up Networking for your connections.  If you are
using a standard Windows-based application then consult Section 3.3 Configuration using
WirelessExpert.

7.1.1. Hardware

To connect the SB320 to a telephone line the 13-pin  I/O connector is used.  Pins 12 and 13 are the
wireline RING and TIP respectively.

For testing purposes, the MIB supports connection of the SB320 to a telephone line with a RJ-11
connector (PSTN).  The SB320 I/O connector must also be in place.

NOTE

The telephone connection must be to a standard analogue telephone line.  Locations
which have an internal PBX telephone system may use digital telephone lines
internally.  Digital lines will NOT work with the modem.

The modem’s load number (5B) is noted on the modem’s back label.

7.2. Configuring the Modem for Wireline

The modem does not require any special configuration for Wireline mode.  The modem is placed
in Wireline mode by setting +WS46=1.

7.2.1. Connecting to another Wireline Modem or Modem Pool

The factory settings (&F0) are fine for wireline operation.  The modem will enable all protocols
up to V.34.  ETC for cellular connections is disabled by default.

7.2.2. Connecting to a Cellular Modem

If the destination modem is on a cellular network, you should familiarize yourself with the
considerations discussed in Sections 4.4 and 4.5 on protocols and handshaking.  The discussion on
CSC in the section above is also worth reading to understand the kinds of issues that can arise.

For these types of connections you should issue the “super” AT command &F6 which
automatically includes additional setup commands as follows:

\N3 Enables V.42 LAPM error control but also allows MNP and will even tolerate a
non-error controlled link.  This allows for both a direct ETC connection to the
destination and a non-ETC connection to a modem pool.  A setting of 2 is also
possible if you want to disconnect if neither LAPM nor MNP error control can be
negotiated.
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-K0 This is a companion to the above command indicating a preference for LAPM
when using V.42.

*H0 This sets the Link Negotiation Speed for the initial connection to a maximum
equivalent to the DTE speed.  It will adapt to the speed of the other modem.

S7=120 The Wait for Carrier is set higher than the default 50 seconds to allow for the
added time of cellular (and possibly modem pool) connections.  This sets the
wait to 120 seconds.

S10=100 Lost Carrier Hang-up Delay is set to 10 seconds.  The default is 0.6 seconds but
cellular links can be interrupted during cell changes and due to other “noise” so
the modem will wait longer to determine if the connection is truly lost.

S51=15 This sets the V.34 symbol rate to 2800 symbols per second and the carrier
frequency control to automatic for transmissions.  The default would allow 3429
symbols per second, which is likely to lead to more failures and retransmissions.

S52=15 This does the same as S51 but for the V.34 receive side.

S55=37 V.34 options are set to enable asymmetric bit rates, and non-linear encoding.  It
disables asymmetric rates, constellation expansion and receiver pre-encoding.

S70=20 This extends the maximum number of retransmissions from the default 12 up to
20.  Higher values are possible if needed.

S96=29 ETC Options are set to enable all features for ETC handshaking except cellular
network compensations are not enabled since your end is non-cellular.  This
includes enabling a fallback to 1200 bps if higher rates cannot be supported.  It
also enables /ETC to be appended to the CONNECT message.

S106=32 The frame size for error correction protocols is set to the minimum 32.  The
default is the maximum of 128.  Use of a small frame size does reduce direct
throughput, but gives a more robust connection.  This leads to fewer
retransmissions and can improve overall throughput in noisy connections that
require frequent retransmissions.

The data rate discussion in Section 6.5.1.1 also applies to this type of connection.

7.3. Originate a Wireline Connection

Watcher (Section 0) can be used to set the modem to Wireline operation.  When set, a call can be
placed using any modem application which can issue a dial command to the COM port.

Alternatively, Windows Dial-up Networking can be configured to establish a connection.  If Dial-
up Networking (or any other communication application) is used to setup the modem, the setup
string should be:

AT &F0 for calls to a wireline modem destination

– OR –

AT &F6 for calls to a cellular modem destination

You may freely add necessary settings to control the local DTE/DCE interface (echo, verbose,
quiet, etc.) without altering the remote connection settings.
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7.4. Auto-answer a Wireline Call

Your application can use the SB320 modem just like any other landline modem.  The modem
setup string should be the appropriate factory setting as indicated in Section 7.3 above.  To enable
auto-answer add:

AT S0=n where n is the ring count on which the modem will answer the line.

You may freely add necessary settings to control the local DTE/DCE interface (echo, verbose,
quiet, etc.) without altering the remote connection settings.
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8. Troubleshooting

8.1. Introduction

Some solutions to common problems are described here.  They are grouped along the lines of the
four operations chapters.  General problems communicating with the modem in the first section
and issues which are specific to particular modes in subsequent sections.

An up to date troubleshooting guide will be available on the Sierra Wireless Internet site at
www.sierrawireless.com.

If you cannot resolve a problem after reading this chapter and consulting our web site, please
contact the Sierra Wireless help desk at (604) 231-1128 (between 06:00 and 17:00 Pacific Time)
or e-mail us at support@sierrawireless.com.

8.2. General Modem Problems

The SB300 Series modems are thoroughly inspected during manufacture.  There are no end-user
access items within the case or on the circuit boards of the modem.  If problems occur, check the
following:

Problem Description Suggestions

WirelessExpert fails to setup
Windows Dial-up
Networking Connection

Watcher fails to locate the
modem.

Use the Windows Start > Settings > Control Panel > Modems to
install the Sierra Wireless modem.

Modem fails when
transmitting.

The LED indicator
(SB300/320) does not light.

Check that the power source has adequate voltage and current.  The
modem requires regulated 5 Vdc at 850 mA.  If the power is marginal it
can be the problem.  The SB300 Series modems draw up to 850 mA
under maximum power output.  The power output is a function of the
modem’s distance from the Mobile Data Base Station.  It is possible for
the modem to work well with a particular power supply in a location
requiring low power output (low current draw), and yet to fail using the
same power supply in a location requiring a high power output.

Check the amperage rating of the power supply to verify that it is
adequate for all situations.

Check the fuse (if any) in the power source and as a final test use a
voltmeter to check for an open cable.

Modem disconnects or resets
intermittently.

Ensure the DTR signal is not floating or being changed by the host.

Set AT&D0 to have the modem ignore DTR.

Verify that CSC radio signal strength is sufficient.  Weak signals may
cause loss of carrier and subsequent disconnection.  Use higher values
in register S10 (Lost Carrier Hang-up Delay).

AT commands are sent to
configure the modem but the
modem does not use the
settings when running an
application.

Verify that the application does not send its own modem setup
commands after you have configured the modem.  If it does, then either
disable the feature or set your configuration in the application’s setup
string.
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8.3. General Communication Problems

Problem Description Suggestions

Fails to respond to AT
command.

Verify that you are using the correct COM port and communication
parameters (speed, data bits, parity, etc.)

Verify the serial cable connections.

Verify the modem is powered on and allow for 10 seconds initialization
time.

Try typing the command ATE1Q0.  This will enable the modem echo
of your keystrokes (in following commands) and disable the quiet mode
(suppression of return codes).

Try typing AT&F.  This restores factory defaults.

Try resetting the modem.

Data is intermittently lost
during the connection.

Ensure that proper flow control is being used at all connections.

If UDP is used, remember that data loss is inherent in the design.
Implement a positive acknowledge and timeout scheme at the
application level with re-transmissions as needed.

If the connection is CSC mode, try setting a slower data rate (register
S37).

8.4. CDPD Problems

This table lists problems specifically related to CDPD use.

Problem Description Suggestions

Fails to lock onto a CDPD
channel.

Make sure that the antenna is connected correctly.

Check that you are in the CDPD coverage area, or that your immediate
location is not preventing the radio/modem from receiving a signal, e.g.,
you are in an area of weak signal strength.

Fails to register on a CDPD
channel.

Make sure the NEI and side designator are configured correctly.

Make sure you are using the correct registration mode (auto or manual)
and are issuing the registration command if using manual registration.
If ATH1 was issued, the modem will not resume auto-registration until
the modem is reset or the command AT+WS173=1 is issued to re-
enable auto-registration.

Check that the correct NEI is being used (Active or Auto-register NEI
Indices) and the SPNI table.  An incorrect value will prevent registration
even in areas with strong signals.  Erase the SPNI table if necessary.

Check with your CDPD service provider to confirm that your account is
activated.  You may need to reset your credentials.

Registers but data transfer
fails.

Check that the host serial cable is properly attached.

There may be a flow control problem.

Slow response from the
CDPD network.

The CDPD network may be congested with heavy use.  No user action
can alleviate this problem.  Retry your connection later.
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CDPD Problems (Continued)

Problem Description Suggestions

Watcher reports: CDPD ras
connection is not running.

Close all communication applications, then close and restart Watcher.

Watcher reports a good
connection and you are
registered to a CDPD
network however your
Internet Web Browser can
never find sites.

Make sure the DNS entry in Dial-up Networking is correct.  This is the
IP address of the Internet Domain Name Server responsible for
converting site names into Internet Protocol (IP) addresses.  Without the
correct IP of a name server your browser cannot locate web sites.

8.5. CSC Problems

This table lists problems specifically related to CSC use.

Problem Description Suggestions

Fails to acquire a Cellular
channel.

Make sure that the antenna is connected correctly.

Check that you are in the cellular coverage area, or that your immediate
location is not preventing the radio/modem from receiving a signal, e.g.,
you are in an area of weak signal strength.

Acquires a channel but
cannot place a call.

Make sure the NAM and side designator are configured correctly.

Check that the correct NAM is being used (Active NAM Index).

Check with your Cellular service provider to confirm that your account
is activated.

If the cellular network becomes congested due to heavy cellular user
traffic, you may not be able to establish a connection.  No user action
can alleviate this problem.  You will have to retry your connection later.

8.6. Wireline Problems

This table lists problems specifically related to wireline use.

Problem Description Suggestions

The Speaker on the MIB is
excessively noisy.

The modem was in CDPD mode and changed to Wireline.  When this
mode change was done, the cellular radio was not powered off.  Power
cycle the modem to ensure the radio is off.

The modem does not go off-
hook to place or answer calls
or intermittently disconnects.

Verify the telephone cable connections at both ends.  You may need to
attach a handset to the line to verify that the PSTN service is active and
connections are clear (free of noise, interference, tones, etc.).

Additionally see the following symptoms and suggestions.

The modem does not go off-
hook to answer incoming
calls.

Verify the auto-answer is enabled (register S0).
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Wireline Problems (continued)

Problem Description Suggestions

The modem does not go off-
hook and begin dialing.

Verify the duration of DTMF tones (register S11) is sufficient to break
dial tone.

Verify the telephone line is analogue and not digital.

The modem won’t recognize
the local dial tone.

Disable the dial tone detection using ATX0 or ATX1.  Ensure the
setting of Wait For Blind Dial (S6) is sufficiently long.

Modem intermittently
disconnects.

Ensure the telephone line does not support call waiting.  If it does then
disable the feature.  Consult your local telephone company to determine
how this is done.
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The Hardware View

9. Product Descriptions

The SB300 Series modems are designed for integration into devices that require wireless
communications such as PC’s, portable and handheld devices, metering and monitoring
equipment, and point of sale terminals.

All models provide CDPD V1.1 19.2 kbps communication.  The SB320 also supports Circuit
Switched Cellular (CSC-AMPS) V.34 data rates to 16.8 kbps, and wireline (PSTN) V.34 data
rates to 33.6 kbps.

Packet Assembly / Disassembly (PAD) services are available in the modem for TCP and UDP
communications.  SLIP and PPP are also supported for host based protocol stacks.

This chapter provides descriptions and specifications for the family.  Individual modems are
described in separate sections below.  All connector parts described are tabulated with mating part
numbers and supplier contact information in Section 9.2.5 below.

The SB300 and SB320 share common physical and interface characteristics.  The SB300 and 302
share common functional characteristics.

9.1. Hardware Integration Considerations

When integrating one of the SB300 Series modems, read Sections 9.2 Specifications Common to
All Modems, and then the specific section for the model being integrated.

In addition, the following items need to be addressed by the integrator:

Mounting
• Effects of shock and vibration.
• Protection from dust and dirt in connections.
• Heat dissipation.

RF
• Shielding and filtering, and impacts on interference and sensitivity.
• Antenna location and type, and impacts on RF performance.

Regulatory Approvals

Although the modems were tested on their own to be compliant with FCC Parts 15 and 22, your
completed installation must be certified to meet regulatory requirements in your area.
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9.2. Specifications Common to All Modems

The following specifications provide information on all SB300 Series modems.

9.2.1. Application Interface Specifications

Serial Interface (DTE)
19200 bps (current firmware R1.0.1)
110 – 115,200 bps (future auto-baud firmware)

SLIP Interface RFC1055

PPP Interface (future firmware) RFC1661, RFC1662, RFC1332 (not yet implemented)

AT-Command Interface Hayes Compatible with PCCA Wireless Extensions

UDP PAD Interface PCCA STD-101 Compliant

TCP PAD Interface PCCA STD-101 Compliant

Object Management Interface Sierra Wireless Inc. Proprietary

9.2.2. RF Features

Transmitter Power 600 mW

Transmitter Performance Meets or exceeds CDPD V1.1 Section 405
FCC, Industry Canada, IS19B/C

Receiver Sensitivity -108dBm 5% BLER

9.2.3. Special Features

Feature Benefit

Sleep Mode Reduces current drain for improved battery life.

TCP and UPD PAD Ping Reply Confirm network connectivity to the modem.

Broadcast Message Support Broadcast to all modems in geographic area.

TCP Session Time-out Permits reconnection of failed TCP session.

“Friends-only” modem access Provides device security.

AutoDial at Startup Modem automatically establishes communications.

Software-controlled Reboot Quick problem recovery.

Autobaud Flexible interface

MultiCast Broadcast to defined subset of all modems.

Configurable Listening Port Modem can listen on any port the host prefers.

Escape from PAD modes Non-DTR controlled Escape.
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9.2.4. Environmental Specifications

SB300 SB302 SB320

Operating Temp. -30 to +65oC -30 to +65oC -30 to +65oC

Storage Temp. -40 to +85oC -40 to +85oC -40 to +85oC

Humidity 5% to 95%
non-condensing

5% to 95%
non-condensing

5% to 95%
non-condensing

Vibration Operational:  IS-19C
Survivability:
  Mil-STD202

None Operational:  IS-19C
Survivability:
  Mil-STD202

Shock 1 metre drop to a hard
surface

None 1 metre drop to a hard
surface

9.2.5. Connector Part Numbers

This section summarizes the parts used, their mating parts, and identifies the suppliers so that you
can acquire the needed connectors for the host equipment / accessories.

9.2.5.1. Antenna Connector

All models of the SB300 Series use the same MMCX type antenna connector.

Modem: Huber & Suhner 85 MMCX-50-0-1 Female

Huber & Suhner 11 MMCX-50-1-1
Straight plug for RG 178 B/U

MaleSuggested Antenna Cable
Connectors:

Huber & Suhner 16 MMCX-50-1-1
Right angle plug for RG 178 B/U

Male

Huber & Suhner can be contacted via www.hubersuhner.com.

9.2.5.2. SB300 and SB320 Host (DTE) Connectors

The SB300 and SB320 both use a 30-pin ZIF connector with 0.5mm pin spacing for the host serial
connection.  The connection is made using a 30-pin 0.5mm pitch Flat Flex Cable.  The host end of
the cable can be connected as suits your needs.

SB300 / 320 Modems: Hirose FH12-30S-0.5SH

Hirose can be contacted via www.hiroseusa.com.

The Cable can be obtained from several suppliers including:
Axon Cable (www.axoncable.com)
Parlex Corp
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SB320 Wireline Connector

The SB320 has an additional wireline connector for connection to the telephone network via the
host.  This is a 13-pin  I/O connector.

SB320 Modem: ITT-Cannon CA112112-1 Male

Host Wireline Connection: Contact ITT-Cannon Female

ITT-Cannon can be contacted via www.ittcannon.com.  Small quantities of mating components
may be obtained from Sierra Wireless, Inc.

9.2.5.3. SB302 Host (DTE) Connectors

The SB302 uses a 2x8 16-pin, 0.1” header connector.  The connection is made using a standard
0.1” header and ribbon cable.  The host end of the ribbon cable can be connected as suits your
needs.

SB302 Modems: AMP 103186-8 (or similar) Male

AMP can be contacted via www.amp.com.
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9.3. SB300 CDPD Modem

Part number 1100034

9.3.1. Mechanical

9.3.1.1. Physical Description

The SB300 comes in a Type III package, and includes a
30-pin, 0.5mm pitch ZIF connector for the host interface,
a MMCX connector for the antenna, and a status LED.  Dimensions (in mm) are as follows:

Figure 9-1:  SB300 Physical Dimensions [mm].

9.3.1.2. Mounting

The SB300 uses an industry standard Type III frame-kit, and as such will fit into PC Card rails.
Alternatively, two clips or a bracket may be used to secure the module.  There are also two
mounting holes provided on either side of the ZIF serial connector.

Figure 9-2:  SB300 Package Views.
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9.3.2. Connectors

See Section 9.2.5 for part number and manufacturer contact details on all connections.

9.3.2.1. Antenna Connector

The SB300 provides an MMCX type RF connector for the antenna connection.  For proper
matching the antenna should be 50 ohms with a return loss of 10 dB or better between
824 - 894 MHz.  System antenna gain should be 0 dB.

9.3.2.2. Host (DTE) Connector

The SB300 provides a single 30-pin ZIF connector with 0.5mm pin spacing.  An appropriate Flat
Flex Cable is required to make the connection to the host.

9.3.3. Power Specifications

The SB300 requires +5V DC provided on pins 23-24, and ground provided on pins 23-28.
Electrical requirements and current specifications are identified below.

Table 9-1: Power and Current Specifications

Power Supply Requirements +5V DC ±5%
Maximum noise DC to 100 kHz: 10 mVpp

Current Drain

Deep Sleep: 12 mA
Sleep: 20 mA
Receive: 150 mA
Transmit (Full Power): 850 mA

9.3.4. Electrical

9.3.4.1. Host (DTE) Interface

The SB300 provides a single 30-pin ZIF connector with 0.5mm pin spacing.  This connector
provides four interfaces:
1. Serial host interface
2. Modem control interface
3. Power
4. Status line interface

The connector pinouts are specified in Table 9-2, and electrical characteristics are specified in
Table 9-3 Serial Interface Electrical Characteristics.  Signal types are with respect to the
modem (DCE).
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Table 9-2: Host Interface Connector Pinouts

Pin Number Pin Label Type Description
1 \DCD Output Data Carrier Detect
2 RxD Output Receive Data
3 TxD Input Transmit Data
4 \DTR Input Data Terminal Ready
5 GND Ground Ground
6 \DSR Output Data Set Ready
7 \RTS Input Ready To Send
8 \CTS Output Clear To Send
9 \RI Output Ring Indicator
10 \RESET Hardware Reset
11 Reserved Leave unconnected
12 \SHDN Input Graceful modem shutdown.
13 \STATUS_OUT1 Output Power + RF Channel Status
14 \STATUS_OUT2 Output Transmitter
15 \STATUS_OUT3 Output Power Down OK
16 STATUS_IN1 Input
17 STATUS_IN2 Input
18 STATUS_IN3 Input
19 STATUS_IN4 Input

20 - 22 Unused Allowed to float
23 – 24 VBAT Input +5V
25 – 28 GND Ground Ground

29 Unused Allowed to float
30 Reserved Leave unconnected

Table 9-3: Serial Interface Electrical Characteristics

Characteristic Min.(V) Max.(V)

Input Low Voltage -0.3 0.8

Input High Voltage 2.5 5.0

Output High Voltage (Ioh=400 µA) 2.4 –

Output Low Voltage (Iol=3.2 mA) – 0.5

Serial Port Interface

The serial port pins comprise a standard set of serial data and handshaking lines.  All signals are
negative assertion, HCMOS logic compatible.  These signals must be terminated properly if they
are not used.  Unused input signals must be pulled to the appropriate in-active state through a
resistor (10k).  Unused output signals may be left unterminated.  If a signal may have use as an
input or an output (I/O) then treat it as an input for termination purposes.

Hardware handshaking should be enabled using \CTS and \RTS as the primary flow control
signals.  The remaining handshaking lines (\DCD, \DTR, \DSR, and \RI) are, strictly speaking, not
needed; however they are desirable for TCP/IP stack usage and are supported for any applications
that may require them.
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Operation in each mode is as follows:
• \RTS, \CTS

Used as standard hardware flow control lines.
• \DTR

Indicates to the modem that the host device is active.  This line may also be configured to
switch the modem from data to command state or reset the modem (AT&D), and to enable
host wake-up.  See the \RI description below.

• \DCD
Is asserted while online with an active session.

• \DSR
Always active when the modem is on; it is tied to logic GND.

• \RI
Current application:  The R1.0.1 firmware release does not use the \RI signal.  It remains
inactive.
Future application:  If \DTR is inactive (high), \RI toggles when there is data for the host.
This may be used to wake-up the host.

The serial port should be configured for 8-data bits, no parity bits, and 1-stop bit.  Although the
current firmware release (R1.0.1) is fixed at 19200 bps, the eventual default DTE configuration
will auto-baud to the host serial baud rate (based on speed of the ‘A’ in an AT command).  Host
data rates of up to 115,200 bps will be supported.  AT commands may be used to fix the baud rate
from 110 bps to 115,200 bps.

In command state, a terminal emulation program may be used to communicate with the modem
and change the configuration.

Modem Control Interface

Modem control is comprised of two inputs:

1. \SHDN: Graceful Shutdown

This is an active low input.

When activated this signal instructs the modem to de-register from the network, and
power down.  When this activity is completed the \STATUS_OUT3 line is driven low
(on) indicating to the host that power may be safely removed from the device.

The modem must be powered down or reset before it is again ready for use.

2. \RESET: Hardware Reset

This is a hardware reset of the modem.  This input should be externally pulled high and
driven low to reset.

Status Signal Interface

Status Outputs

There are three status outputs provided.  These are active low and defined as follows:

1. \STATUS_OUT1: Power, RF Channel Status
• Permanently low (on) when power is on but no CDPD channel is visible.  This

output is high (off) when the modem goes into logic sleep.
• Pulses low (on) once per second with 10% duty cycle if modem is locked onto a

CDPD channel.
• Pulses low (on) twice per second with 10% duty cycle if modem is registered on a

CDPD channel.

2. \STATUS_OUT2: Transmitter
• Low (on) when the transmitter is keyed.
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3. \STATUS_OUT3: Power Down OK
• When low (on), this indicates it is safe to remove power to the modem.  This works

in concert with the \SHDN signal noted above.

Status Inputs

There are four TTL-level status input lines provided.  There are currently no features that use these
inputs.  They are managed within the modem and may be left floating.
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9.4. SB302 Specifications

Part number 1100043

9.4.1. Mechanical

9.4.1.1. Physical Description

The SB302 comes as a board stack of two circuit
boards.  It includes a 16-pin, 0.1” dual-row header for
the host interface and an MMCX style RF connector for the antenna.  Dimensions in millimetres
are as follows:

Figure 9-3: Physical dimensions shown in inches [mm]. Figure 9-4: Assembly View.

9.4.2. Connectors

See Section 9.2.5 for part number and manufacturer contact details on all connections.

9.4.2.1. Antenna Connector

The SB302 provides an MMCX type RF connector for the antenna connection.  For proper
matching the antenna should be 50 ohms with a return loss of 10 dB or better between
824 - 894 MHz.  System antenna gain should be 0 dB.
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9.4.2.2. Host (DTE) Connector

The SB302 provides a single (2 x 8) 16-pin connector.

9.4.3. Power Specifications

The SB302 requires +5V provided on pins 1 and 2, and ground provided on pins 3 and 4.
Electrical requirements and current specifications are identified below.

Table 9-4: Power and Current Specifications

Power Supply Requirements +5V DC ±5%
Maximum noise DC to 100 kHz: 10 mVpp

Current Drain

Deep Sleep: 12 mA
Sleep: 20 mA
Receive: 150 mA
Transmit (Full Power): 850 mA

9.4.4. Electrical

9.4.4.1. Host (DTE) Interface

The SB302 provides a single 16-pin connector that provides four interfaces:
1. Serial host interface
2. Modem control interface
3. Power
4. Status line interface

The connector pinouts are specified in Table 9-5, and electrical characteristics are specified in
Table 9-6 Serial Interface Electrical Characteristics.  Signal types are with respect to the
modem (DCE).

Table 9-5: Host Interface Connector Pinouts

Pin Number Pin Label Type Description
1 – 2 VBAT Input +5V
3 – 4 GND Ground Ground

5 TxD Input Transmit Data
6 RxD Output Receive Data
7 \DTR Input Data Terminal Ready
8 \DCD Output Data Carrier Detect
9 \DSR Output Data Set Ready
10 \CTS Output Clear To Send
11 \RTS Input Ready To Send
12 \RI Output Ring Indicator
13 \SHDN Input Graceful modem shutdown.
14 \STATUS_OUT1 Output Power + RF Channel Status
15 \STATUS_OUT2 Output Transmitter
16 \STATUS_OUT3 Output Power Down OK
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Table 9-6: Serial Interface Electrical Characteristics

Characteristic Min.(V) Max.(V)

Input Low Voltage -0.3 0.8

Input High Voltage 2.5 5.0

Output High Voltage (Ioh=400 µA) 2.4 –

Output Low Voltage (Iol=3.2 mA) – 0.5

Serial Port Interface

The serial port pins comprise a standard set of serial data and handshaking lines.  All signals are
negative assertion, HCMOS logic compatible.  These signals must be terminated properly if they
are not used.  Unused input signals must be pulled to the appropriate in-active state through a
resistor (10k).  Unused output signals may be left unterminated.  If a signal may have use as an
input or an output (I/O) then treat it as an input for termination purposes.

Hardware handshaking should be enabled using \CTS and \RTS as the primary flow control
signals.  The remaining handshaking lines (\DCD, \DTR, \DSR, and \RI) are, strictly speaking, not
needed; however they are desirable for TCP/IP stack usage and are supported for any applications
that may require them.  Operation in each mode is as follows:
• \RTS, \CTS

Used as standard hardware flow control lines.
• \DTR

Indicates to the modem that the host device is active.  This line may also be configured to
switch the modem from data to command state or reset the modem (AT&D), and to enable
host wake-up.  See the RI description below.

• \DCD
Is asserted while online with an active session.

• \DSR
Always active when the modem is on; it is tied to logic GND.

• \RI
Current application:  The R1.0.1 firmware release does not use the \RI signal.  It remains
inactive.
Future application:  If \DTR is inactive (high), \RI toggles when there is data for the host.
This may be used to wake-up the host.

The serial port should be configured for 8-data bits, no parity bits, and 1-stop bit.  Although the
current firmware release (R1.0.1) is fixed at 19200 bps, the eventual default DTE configuration
will auto-baud to the host serial baud rate (based on speed of the ‘A’ in an AT command).  Host
data rates of up to 115,200 bps will be supported.  AT commands may be used to fix the baud rate
from 110 bps to 115,200 bps.

In command state, a terminal emulation program may be used to communicate with the modem
and change the configuration.

Modem Control Interface

Modem control is comprised of one input:

1. \SHDN: Graceful Shutdown

This is an active low input.

When activated this signal instructs the modem to de-register from the network, and
power down.  When this activity is completed the \STATUS_OUT3 line is driven low
(on) indicating to the host that power may be removed from the device.

The modem must be powered down and restarted before it is again ready for use.
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Status Signal Interface

Status Outputs

There are three status outputs provided.  These are active low and defined as follows:

1. \STATUS_OUT1: Power, RF Channel Status
• Permanently low (on) when power is on but no CDPD channel is visible.  This

output is high (off) when the modem goes into logic sleep.
• Pulses low (on) once per second with 10% duty cycle if modem is locked onto a

CDPD channel.
• Pulses low (on) twice per second with 10% duty cycle if modem is registered on a

CDPD channel.

2. \STATUS_OUT2: Transmitter
• Low (on) when the transmitter is keyed.

3. \STATUS_OUT3: Power Down OK
• When low, (on) this indicates it is safe to remove power to the modem. This works in

concert with the \SHDN signal noted above.
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9.5. SB320 Specifications

Part number 1100033

9.5.1. Mechanical

9.5.1.1. Physical Description

The SB320 comes in a Type III package, and includes
a 30-pin, 0.5mm pitch ZIF connector for the host
interface, a 13-pin  I/O connector for the wireline
interface, a MMCX connector for the antenna, and a status LED.  Dimensions in millimetres are as
follows:

Figure 9-5:  SB320 Physical Dimensions [mm].

9.5.1.2. Mounting

The SB320 uses an industry standard Type III frame-kit, and as such will fit into PC Card rails.
Alternatively, two clips or a bracket may be used to secure the module.  There are also two
mounting holes provided on either side of the ZIF serial connector.

Figure 9-6:  SB320 Package Views.
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9.5.2. Connectors

See Section 9.2.5 for part number and manufacturer contact details on all connections.

9.5.2.1. Antenna Connector

The SB320 provides an MMCX type RF connector for the antenna connection.  For proper
matching the antenna should be 50 ohms with a return loss of 10 dB or better between
824 - 894 MHz.  System antenna gain should be 0 dB.

9.5.2.2. Host (DTE) Connector

The SB320 provides a single 30-pin ZIF connector with 0.5mm pin spacing.  An appropriate Flat
Flex Cable is required to make the connection to the host.

9.5.2.3. Wireline Connector

The SB320 provides a single 13-pin I/O connector next to the antenna connector on the side
opposite the host (DTE) connector.  This connector may require custom cabling.

The SB320 PSTN Load Number (5B) is shown on the back label.

9.5.3. Power Specifications

The SB320 requires +5V DC provided on pins 23-24, and ground provided on pins 23-28.
Electrical requirements and current specifications are identified below.

Table 9-7: Power and Current Specifications

Power Supply Requirements +5V DC ±5%
Maximum noise dc to 100 kHz: 10 mVpp

Current Drain Wireline Mode
Inactive: 20 mA
Transmit: 220 mA

Current Drain CSC Mode
Receive: 190 mA
Transmit (Full Power): 850 mA

Current Drain CDPD Mode

Deep Sleep: 35 mA
Sleep: 45 mA
Receive: 190 mA
Transmit (Full Power): 760 mA

9.5.4. Electrical

9.5.4.1. Host (DTE) Interface

The SB320 provides a single 30-pin ZIF connector with 0.5mm pin spacing.  This connector
provides four interfaces:
1. Serial host interface
2. Modem control interface
3. Power
4. Status line interface
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The connector pinouts are specified in Table 9-8, and electrical characteristics are specified in
Table 9-9 Serial Interface Electrical Characteristics.  Signal types are with respect to the
modem (DCE).

Table 9-8: Host Interface Connector Pinouts

Pin Number Pin Label Type Description
1 \DCD Output Data Carrier Detect
2 RxD Output Receive Data
3 TxD Input Transmit Data
4 \DTR Input Data Terminal Ready
5 GND Ground Ground
6 \DSR Output Data Set Ready
7 \RTS Input Ready To Send
8 \CTS Output Clear To Send
9 \RI Output Ring Indicator
10 \RESET Hardware Reset
11 Reserved Leave unconnected
12 \SHDN Input Graceful modem shutdown.
13 \STATUS_OUT1 Output Power + RF Channel Status
14 \STATUS_OUT2 Output Transmitter
15 \STATUS_OUT3 Output Power Down OK
16 STATUS_IN1 Input
17 STATUS_IN2 Input
18 STATUS_IN3 Input
19 STATUS_IN4 Input

20 – 22 Unused Allowed to float
23 – 24 VBAT Input +5V
25 – 28 GND Ground Ground

29 Unused Allowed to float
30 Reserved Leave unconnected

Table 9-9: Serial Interface Electrical Characteristics

Characteristic Min.(V) Max.(V)

Input Low Voltage -0.3 0.8

Input High Voltage 2.5 5.0

Output High Voltage (Ioh=400 µA) 2.4 –

Output Low Voltage (Iol=3.2 mA) – 0.5

Serial Port Interface

The serial port pins comprise a standard set of serial data and handshaking lines.  All signals are
negative assertion, HCMOS logic compatible.  These signals must be terminated properly if they
are not used.  Unused input signals must be pulled to the appropriate in-active state through a
resistor (10k).  Unused output signals may be left unterminated.  If a signal may have use as an
input or an output (I/O) then treat it as an input for termination purposes.

Hardware handshaking should be enabled using \CTS and \RTS as the primary flow control
signals.  The remaining handshaking lines (\DCD, \DTR, \DSR, and \RI) are, strictly speaking, not
needed; however they are desirable for TCP/IP stack usage and are supported for any applications
that may require them.
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Operation in each mode is as follows:
• \RTS, \CTS

Used as standard hardware flow control lines.
• \DTR

Indicates to the modem that the host device is active.  This line may also be configured to
switch the modem from data to command state or reset the modem (AT&D), and to enable
host wake-up.  See the RI description below.

• \DCD
Is asserted in CDPD mode while online with an active session.  Behaviour options in CSC
and Wireline modes are set with the command AT&C.

• \DSR
Always active when the modem is on; it is tied to logic GND.

• \RI
In Wireline and CSC modes, this line toggles when there is an incoming call (the telephone is
ringing).
In CDPD mode
Current application:  The R1.0.1 firmware release for CDPD does not use the \RI signal.  It
remains inactive.
Future application:  If \DTR is inactive (high), \RI toggles when there is data for the host.
This may be used to wake-up the host.

The serial port should be configured for 8-data bits, no parity bits, and 1-stop bit.  Although the
current firmware release (R1.0.1) is fixed at 19200 bps, the eventual default DTE configuration
will auto-baud to the host serial baud rate (based on speed of the ‘A’ in an AT command).  Host
data rates of up to 115,200 bps will be supported.  AT commands may be used to fix the baud rate
from 110 bps to 115,200 bps.

In Circuit-Switched mode data state and any mode’s command state, a terminal emulation
program may be used to communicate with the modem and change the configuration.

Modem Control Interface

Modem control is comprised of two inputs:

1. \SHDN: Graceful Shutdown

This is an active low input.

When activated this signal instructs the modem to de-register from the network, and
power down.  When this activity is completed the \STATUS_OUT3 line is driven low
(on) indicating to the host that power may be removed from the device.

The modem must be powered down or reset before it is again ready for use.

2. \RESET: Hardware Reset

This is a hardware reset of the modem.  This input should be externally pulled high and
driven low to reset.

Status Signal Interface

Status Outputs

There are three status outputs provided.  These are active low and defined as follows:

1. \STATUS_OUT1: Power, RF Channel Status
• Permanently low (on) when power is on but no cellular channel is acquired.  This

output is high (off) when the modem is in CDPD and goes into logic sleep.
• Pulses low once per second with 10% duty cycle if modem has acquired a cellular

channel.
• Pulses low twice per second with 10% duty cycle if modem is registered on a CDPD

channel.
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2. \STATUS_OUT2: Transmitter
• Low (on) when the transmitter is keyed.

3. \STATUS_OUT3: Power Down OK (not yet implemented)
• When low (on), this indicates it is safe to remove power to the modem.  This works

in concert with the \SHDN signal noted above.

Status Inputs

There are four TTL-level status input lines provided.  There are currently no features that use these
inputs.  They are managed within the modem and may be left floating.

9.5.4.2. Wireline and Voice Interface

The SB320 provides a 13-pin I/O connector for its wireline interface.  The connector is positioned
on the opposite end of the housing from the serial host (DTE) connector.  This connector provides
these interfaces:
1. Telephone Line Interface
2. Status Outputs 1 and 2

The connector pinouts are specified in Table 9-10.  Specific configuration detail for the different
interfaces follow.  Signal types are with respect to the modem (DCE).

Table 9-10: Pinout of Wireline and Voice Connector

Pin number Signal Name Type Description
1 Reserved Leave Unconnected
2 SPKR– Output Speaker Interface negative
3 SPKR+ Output Speaker Interface positive

4 – 7 Reserved Input Leave Unconnected
8 \STATUS_OUT1 Output Power + RF Channel Status
9 \STATUS_OUT2 Output Transmitter
10 GROUND Ground Signal Ground
11 Reserved Leave Unconnected
12 RING Input Wireline Connection
13 TIP Input Wireline Connection

Telephone Line Interface

PSTN Line Connection

The telephone line interface consists of two signals: TIP and RING.  These two lines should be
routed via a twisted-pair wire to a panel-mounted RJ-11 connector.  The PSTN Load Number (5B)
is noted on the back label of the modem.

Note that is provides connection to analogue telephone lines only.  Connection to digital PBX
lines is not supported.

Speaker Output

The speaker output is a differential signal used to interface to a speaker amplifier.  The output
signal is AC-coupled 2 Vp-p nominal into a 150 ohm load.  In circuit-switched and wireline data
modes this signal is used to indicate call progress.

Status Outputs

These signals are the status outputs from the host interface brought out on the wireline/voice
connector.  They are duplicates of the signals described in Section 9.5.4.1 above.
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9.5.5. SB320 Communication Mode Specifications

9.5.5.1. Wireline Specifications

Wireline Data CCITT V.34: 33600 – 2400 bps
CCITT V.32bis: 14400, 12000, 7200 bps
CCITT V.32: 9600, 4800 bps
CCITT V.22bis: 2400 bps
CCITT V.22: 1200 bps
CCITT V.21: 300 bps
Bell 212A/103: 1200, 300 bps

V.42 error correction (LAPM and MNP)
V.42bis and MNP5 data compression

9.5.5.2. Circuit-Switched Data Specifications

CSC Data CCITT V.34: 16800 – 2400 bps
CCITT V.32bis: 7200 bps
CCITT V.32: 9600, 4800 bps
CCITT V.22bis: 2400 bps
CCITT V.22: 1200 bps
CCITT V.21: 300 bps
Bell 212A/103: 1200, 300 bps

V.42 error correction (LAPM and MNP)
V.42bis and MNP5 data compression
ETC

CSC General IS-91

9.5.5.3. CDPD Specifications

CDPD Version CDPD 1.1
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10. Multipurpose Interface Board

10.1. Introduction

The Multipurpose Interface Board (MIB) is a
development aid to facilitate testing and configuration
of the SB300 Series modems by allowing
communication using a standard RS-232 serial
connection.  It also provides monitoring LEDs, test
points, connections for a protocol analyzer, and
connections for wireline (PSTN) hookup.

There is also support for the SB220 and SB301
modem.  These supports are provided for factory level testing only and are beyond the scope of
this document.  The SB302 shares several connectors and signal controls with the SB301.

NOTE

Although the MIB provides support for the full SB Series of modems, it is not intended
to support more than one modem at a time.  Attaching more than one modem can
damage circuitry.

For a quick initial setup go to Section 10.8.  To get a fuller understanding of the board’s
connections and capabilities sections are provided as follows:

• Section 10.2 Board Description with schematic and parts layout reference.
• Section 10.3 Power Supply including voltage control and supplying power from a host device.
• Section 10.4 Connections describing the various host, modem, and analyzer connectors.
• Section 10.5 Jumpers details options and setups.
• Section 10.6 Serial Breakout Box describes cross wiring correction and signal checking
• Section 10.7 Test Points identifies what is offered and where to find it

10.1.1. Features

The MIB offers these features:
• Supports SB220, SB300, SB302, SB320
• RS232 to 5V HCMOS conversion
• Interception of 5V HCMOS control signals from host to modem to verify syntax and levels
• Intercepted signals are converted to RS-232 for observation by standard serial port
• Supports wireline access
• Serial port breakout box to resolve cabling difficulties
• Serial port status LEDs
• Status line LEDs and pullup/down
• Current, DISC and KEY test points
• Reset button for SB300 and SB320
• Annunciator to hear dial tones
• Comm Analyzer connectors - 25 pin protocol analyzer
• Uses wall adapter for power
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10.2. Board Description

10.2.1. Schematic

See the following two insert pages.

10.2.2. Parts Layout

See the third following insert page.
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10.3. Power Supply

The MIB requires a 12V DC, 1 Amp power supply.  An AC adapter (part number 1900000) is
provided with the OEM Developer’s Toolkit.

This power is converted by the MIB into the 5V (and 7V for the SB220) supply needed by the
modems.  It is not designed to support more than one modem connected to the MIB at any time.

There is a power switch on the MIB that controls delivery of both the 5V and 7V supplies to the
modem connectors but DOES NOT control the 5V supply to the MIB’s own logic.  The MIB’s
logic is on whenever the 12V supply is connected.

The normal initial setup has jumper J21 (Power Select) set on pins 1 and 2 which will deliver
power to the modem from the MIB’s power source.

10.3.1. Voltage Adjustment

A trim-pot is provided to make fine adjustments to the 5V supply, accommodating cable loss and
allowing you to test the modem under various power conditions.

NOTE

At this time the 5V power adjustment will also affect the 5V supply to the MIB’s own
logic.  Extreme settings may cause failures of the MIB that should not be interpreted as
failures of the modem.

There is protection circuitry intended to prevent the trim-pot from setting values high enough to
damage the MIB or modem.  The range is approximately 5V +5%/–10%.

The 5V supply can be measured at test point TP3 or at pin 1 of the power select jumper (J21).

The 7V supply does not have adjustment controls.

10.3.2. Using Power from Host (DTE)

For users testing a host connection to a SB302, it is possible to power the modem from the host
(DTE) device rather than the MIB.  To do this, connect the host to the 2x8-pin block
(J9 SB301/302 To Host) and set jumper J21 (Power Select) to pins 2 – 3 (+5V Host).

At this time, there is no provision for a similar host connection to the SB300 or SB320.  These
modems do however derive power from the source set by jumper J21 (Power Select) so this must
be set to pins 1 – 2 for normal operation.  A workaround to allow host power to supply the modem
is to patch the host power to pins 1 and 2 of the SB301/302 host connector block (J9) and set the
power select jumper (J21) to pins 2 – 3.

The MIB’s 12V power supply must remain on to deliver power to the RS-232 / HCMOS
conversion logic.  The DTE/DCE serial lines are converted to RS-232, made available at the Serial
Breakout Box, and then converted back to HCMOS at each end.

10.4. Connections

This section provides information on the use of the various connectors on the MIB.

10.4.1. PC Host (DTE) RS-232 Serial Connection

There are two 9-pin D connectors (female) provided on the MIB to connect to standard RS-232
serial ports on a host terminal, usually a PC.
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PC Serial Port

This connection is for a PC host device running a terminal emulation program.  Communication to
and from this port is delivered via the Serial Breakout Box, to and from the modem.

Debug Port

The second 9-pin D connector is for factory level testing only.

10.4.2. Host (DTE) Connection for SB302

An alternative to the 9-pin RS-232 serial connector (PC Serial Port) is provided for connecting a
host (DTE) device to a SB302 via the 2x8-pin block at J9 (SB301/302 To Host).  This connector
allows you to insert the MIB between the host and the modem for testing and monitoring
communications.

Although there is not currently an equivalent 30-pin ZIF host connector for the SB300 and SB320,
the pins of this connector are also delivered to the SB300 / SB320 modem connectors.

Serial Signals

The MIB converts the serial communication signals to RS-232 level, presents them at the Serial
Breakout Box and then converts them back to HCMOS level before passing them to the DTE/DCE
ends.

NOTE: In order for this signal conversion to work, the host device MUST supply +5V on pins 1
and 2.  It is this power which enables the conversion logic on the MIB for the host side.

Input Signals

The modem’s three \STATUS_OUT signals are passed directly between the modem and the host.
They can also be monitored by the three LEDs (SO1, SO2, SO3)

Output Signals

The host Shutdown signal is passed to the modem via an enabling jumper (HOSTSHDN) on the
main jumper block.  With the jumper removed, the shutdown signal is blocked from reaching the
modem.

Power from the host can be used to power the modem by setting jumper J21 (Power Select) to pins
2 –3 (+5V Host).  With the jumper in the original position (pins 1 – 2) the modem is powered from
the MIB.  See Section 10.3.2 for details.

10.4.3. Protocol Analyzer Connection

Two 25-pin D connectors are available to connect a protocol analyzer in the serial signal path.
The female connector is on the PC side of the Serial Breakout Box; the male connector is on the
modem side.

To monitor the communication signals between the host and modem, simply connect the analyzer
to the MIB.

10.4.4. SB300 / SB320 Modem Connection

Both the SB300 and SB320 use a 30-pin ZIF connector.  The connector uses the Flat Flex Cable
ribbon (Sierra Wireless part number 2000068) provided with the OEM Developer’s Toolkit.

The connection provides all defined pinouts.

Use care when attaching the ribbon to the connector.  There is a cover clamp that hinges up to
open the connector.  Slide the ribbon into the connector with the insulated (coloured) side of the
ribbon facing up.  Close the connector clamp by pressing down at the ends rather than the centre
of clamp.  The modem has an identical clamp connector.
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Serial Signals

The MIB converts the serial communication signals to RS-232 level, presents them at the Serial
Breakout Box and then passes them to the DTE/DCE ends.

The DCE (modem) side of this conversion can be disabled, effectively disconnecting the modem
from the MIB by placing a jumper on the MODEM DISBL pins of the main jumper block.  This
can be useful if you are using a protocol analyzer to emulate the DCE device.

Input Signals

The 5V power comes from the MIB via the jumper J21 (Power Select).  Pins 1 – 2 will connect the
MIB adjustable 5V supply.

All other input signals (Shutdown (\SHDN) and status inputs 1 – 4) to the modem are supplied
from the main jumper block.  Placing a jumper on the pins will make the signal active.

Output Signals

The three modem \STATUS_OUT signals are indicated by the three LEDs (SO1, SO2, SO3).
These are lit when the output signal is active (low).

10.4.5. SB302 Modem Connection

The SB302 uses a 2x8 pin connector block.  A strap with connectors at each end (part
number 2000067) is provided with the OEM Developer’s Kit.  This strap allows connection of the
modem to the MIB at J7 (To SB301/302).

Serial Signals

The MIB converts the serial communication signals to RS-232 level, presents them at the Serial
Breakout Box and then passes them to the DTE/DCE ends.

The DCE (modem) side of this conversion can be disabled, effectively disconnecting the modem
from the MIB by placing a jumper on the MODEM DISBL pins of the main jumper block.  This
can be useful if you are using a protocol analyzer to emulate the DCE device.

Input Signals

The 5V power and Shutdown (\SHDN) signal to the modem can be supplied from either the MIB
or the Host (DTE) connection (not the PC Host RS-232 connection).

Modem power can be drawn from either the MIB or the host (DTE) by setting the jumper J21
(Power Select).  Pins 1 – 2 will connect the MIB adjustable 5V supply.  Pins 2 –3 (+5V Host) will
connect the host power to the modem.  See Section 10.3.2 for details.

The Shutdown (\SHDN) signal must originate from the Host (DTE) connection (not the PC Host
RS-232 connection).  It can be enabled or disabled via a jumper (HOSTSHDN).  With the jumper
connector in, the shutdown signal will be passed to the modem.  With the jumper removed, the
signal is blocked.

The Shutdown signal can also be originated at the MIB using the SB3XX SHDN jumper on the
main jumper block.  Placing a jumper on the pins will make the signal active (low).

Output Signals

The three modem \STATUS_OUT signals are passed directly between the modem and the Host
(DTE) connector.  Their status is also indicated by the three LEDs (SO1, SO2, SO3).  These are lit
when the output signal is active (low).

10.4.6. SB220 Modem Conneciton

This is provided for factory testing of older model modems not detailed in this manual.
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10.5. Jumpers

There are five jumper blocks provided on the MIB.  Two of these are for the SB220, which is not
covered in this document.  The three blocks used with the SB300 Series modems are summarized
below and discussed in detail in following sections.

The main jumper block is located next to the modem power switch and has eight pairs of pins.

When the jumper is connected it has these functions.
• ST IN1 Activate the input signals (not currently implement
• ST IN2 on the modems).
• ST IN3
• ST IN4
• \SHDN Activate the \SHDN signal to the modem.
• HOSTSHDN Enable the \SHDN signal from the SB301/302 host connector.
• TP CTRL Enable test point TP3.
• MODEM DIS Disable the RS-232 serial connection from the modem.

There is also a 3-pin jumper block for power selection.  A jumper MUST connect the centre
pin (2) to one of the outside pins (1 or 3) to enable power to the modem.
• 1 – 2 MIB power is used.
• 2 – 3 Host power (SB301/302 host connector) is used.

A 2-pin jumper block is available to enable or disable the built-in speaker.  When the jumper is
connected, the speaker is enabled.

10.5.1. Main Jumper Block

The main jumper block (J24) has eight pairs of pins, all labelled.  NOTE that a correcting label has
been applied to reverse the labels for \SHDN and HOSTSHDN.

The first four pairs are to activate the four input signals of the SB320 (not currently implemented
by the modem).  Two pairs are for direct MIB activation of the Shutdown (\SHDN) signal to the
modems and to enable the SB302 host interface to trigger this signal.  There is one pair of pins for
activating TP3 and the last pair is to disable the modem side of the RS-232 / HCMOS serial signal
conversion.

10.5.1.1. ST INx – Status Inputs

Placing a jumper on one of these pins will force the signal active.  At this time none of the status
input signals are used by the SB320 or SB300.

10.5.1.2. \SHDN – Shutdown

This jumper forces the modem’s Shutdown (\SHDN) input active (low).  Placing a jumper on this
pair of pins forces the signal on.  This will work regardless of the jumper setting of the host
shutdown enable.

10.5.1.3. HOSTSHDN – Host Shutdown Enable

This jumper enables the Shutdown (\SHDN) signal from the SB301/302 host interface to be
passed to the modem.  Without the jumper installed, the signal will not reach the modem.  This
jumper does not activate the signal; only allow the signal from the host connector to be passed to
the modem.

If the SB301/302 host connector is not being used, this jumper should be left open (not
connected).  This will prevent a floating signal from the host connector block from reaching the
modem.

This jumper in independent of the forced-shutdown jumper (\SHDN).
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10.5.1.4. TP CTRL

Test Point 5 is tied to this jumper.  When the jumper is removed, the test point delivers GND;
when the jumper is inserted it delivers the MIB’s 5V DC, independent of the modem’s power
supply.

10.5.1.5. MODEM DISBL

Placing a jumper on this pair of pins will disable the MIB’s conversion of the modem serial
connection from HCMOS level to RS-232 level, effectively disconnecting the modem from the
Serial Breakout Box and the host (both PC and direct SB302 host connection).  Power and the
control signals \SHDN and \STATUS_OUT1 – 3 remain intact.

10.5.2. Power Select

A 3-pin block is provided to select the source of the +5V power supply to the modems.  Placing
the jumper on pins 1 and 2 will connect the MIB’s regulated +5V supply.  Placing the jumper on
pins 2 and 3 will connect the modem to power from the SB301/302 Host connection and remove
the trim pot.

The modem power switch comes AFTER the power selection jumper and can be used to control
power to the modems regardless of the source of the power.

10.5.3. SPK EN – Speaker Enable

A 2-pin block is provided to allow you to disable the speaker in situations where you would prefer
to mute the output.  Placing the jumper on the pins will enable the SB320 to drive the speaker,
provided the SB320 I/O connector is in place.

The SB300 and SB302 modems do not provide speaker output.  The SB320 speaker output is
driven through the wireline connector (SB320 I/O).

10.6. Serial Breakout Box

One of the main functions of the MIB is to provide a means of monitoring the serial connection
between a host and the modem.  The MIB converts HCMOS level signals at the modem (and at
the SB301/302 Host connection) to RS-232 level for monitoring on the LEDs and with a protocol
analyzer.

In addition, the two rows of pins on each side of the DIP switch provide test points and
connections to each individual signal.  This allows you to cross connect pins to correct cabling or
connector faults.

10.6.1. DIP Switch

The DIP switch is used to make or break the connection between the host and modem for each of
the serial communication signals.  When switched to the open side, the connection is broken.

Should there be a cross connection error in the host / modem serial connection, switch off the
affected signals and use the breakout pins to bridge the signal correctly.

The last two switches are not connected.

10.6.2. Serial Connection Indicators

The LED indicators show the status of the serial communication on the modem side of the
breakout box.  Red indicates an inactive signal, green indicates an active one.  All LEDs are
labelled.
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10.7. Test Points

There are six test points plus a pair of pins for current measurement.  The sixth test point is not
used at this time.

10.7.1. TP1 DISC

This test point receives its signal from pin 30 of the SB320 modem connector and pin 1 of the
SB320 I/O connector.  It presents the discriminator output of the radio modem.

10.7.2. TP2 KEY

All modem connectors provide the transmitter key indicator here.  This signal is also indicated by
the S02 status LED.

10.7.3. TP3 5V Adjusted

The power output after the 5V ADJ trim pot can be measured here.

10.7.4. TP4 5V Setting

This test point is for factory presets only.

10.7.5. TP5 Debug for 5V / GND

This is connected to the TP CTRL jumper of the main jumper block and is available for debug
testing the MIB’s power supply.  When the jumper is removed, the test point delivers GND; when
the jumper is inserted it delivers the MIB’s 5V DC, independent of the modem’s power supply.

10.7.6. TP6 Unused

Connected to the SB320 pins 20, 21, and 22, these signals are currently unused.

10.7.7. Current Measurement

Two pins are made available at J26 (Current Measurement) to allow calculation of the current
drawn by the modem.  The calculation is based on V = I x R, where V is the measured voltage and
R is a known resistance (0.1 ohm).  This formula reduces to I = 10 x V.

Measure the Voltage across the two pins.  This is typically greater than 1 mV and less than 90 mV.
The current being drawn, in mA, is equivalent to 10 times the voltage measured in mV.

10.8. Reset Button

The reset button sends the reset control signal to the SB300 and SB320 connectors.  The SB302
does not support a reset input signal.
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10.9. Initial Setup

As shipped the MIB is configured as follows:
• Serial communication DIP switches are closed and the two spare switches are left open.
• Power select is on pins 1 and 2 to use MIB power for the modem.
• The following main jumpers are connected:

• ST IN1 – ST IN4 (Status Inputs to SB320) These are unused currently and simply
provide a “parking space” for jumpers which can be used as needed elsewhere.

• TP CTRL allowing for measurement of the MIB’s 5V power supply.
• The speaker is enabled.

The 5V power adjustment is set in the factory for 5V.


